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1. Introdução 

 

1.1. Motivação 

 

Um dos maiores obstáculos à implementação de dispositivos electrónicos no interior do 

corpo humano ou em outros tecidos vivos, prende-se com o facto de os sistemas biomédicos 

implantáveis, necessitarem de pilhas ou baterias para o seu funcionamento, sendo estes os 

responsáveis por uma grande parte das falhas que ocorrem neste tipo de dispositivos.  

Uma das soluções alternativas para este problema, consiste na utilização de fios que 

atravessam a pele. A utilização de fios que atravessam a pele para alimentar dispositivos 

implantados, para além do possível desconforto que possa causar, não é uma opção viável devido 

ao elevado risco de infecções e/ou quebra das ligações. Os fios só devem ser utilizados em 

ocasiões muito especiais e durante períodos de tempo reduzidos.  

Uma alternativa à utilização dos fios, consiste na realização de um link electromagnético, 

que para além de permitir alimentar os dispositivos implantados, possibilita, sem muita 

complexidade adicional, o estabelecimento de um canal de comunicação bidireccional entre o 

dispositivo implantado e o exterior. A utilização do link electromagnético, permite ainda obter 

sinais biológicos medidos por sensores implantados dentro de tecidos vivos, sem mais uma vez 

termos que lidar com fios que perfuram a pele [1]. Por último, e muito importante, permite a 

redução do número de cirurgias necessárias para a substituição das pilhas. 

A utilização de um link electromagnético para alimentar e comunicar com sistemas 

implantados, abre um elevado leque de possibilidades e aplicações, sendo por isso uma área que 

interessa pesquisar e desenvolver. A aplicação da engenharia para o desenvolvimento e posterior 

adaptação de dispositivos e equipamentos electrónicos ou mecânicos em seres vivos, requer a 

entreajuda de diversas disciplinas. A união entre a engenharia e a ciência, providencia os 

mecanismos necessários para o desenvolvimento de equipamentos com a finalidade de prolongar 

e melhorar a vida dos seres vivos, nomeadamente os portadores de deficiências físicas. 
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1.2. Sistemas Electrónicos In-Vivo 

 

InVivo é a expressão que define o estudo dos organismos vivos como um todo, 

nomeadamente, a introdução de sistemas (electrónicos ou mecânicos) no interior de organismos 

vivos, sistemas esse, com requisitos especiais quer em termos de fiabilidade, dimensão, 

durabilidade e nível de integração, utilizando encapsulamentos biocompatíveis. 

Existe um grande número de implantes médicos, que podem ser caracterizados em dois 

grandes grupos: activos ou passivos. Exemplos de implantes passivos são o caso das junções 

artificiais das quais se destacam as próteses e os implantes vasculares como as válvulas artificiais. 

Os implantes activos necessitam de energia proveniente de fontes externas para poderem 

funcionar. Um dos exemplos de um implante activo, são os pacemakers cardiovasculares que 

recorrem a pilhas para funcionarem. 

 

Fornecer energia a implantes activos (não considerando a utilização de fios) pode ocorrer 

de duas maneiras: 

• Recorrendo a baterias, que acabam por necessitar de um elevado volume e 

necessitam de ser substituídas, obrigando à realização de operações periódicas; 

• Recorrer a uma fonte de alimentação externa que normalmente se baseia na 

realização de um link electromagnético, tendo em atenção todas as imposições legais. 

 

A utilização do link electromagnético tem as seguintes vantagens: 

• Permite a transferência bidireccional de dados 

• O tempo de vida do implante deixa de ser condicionado pela alimentação 

 

Tem no entanto as seguintes desvantagens: 

• O implante tem que estar na posição correcta para poder ser adequadamente 

alimentado 

• O risco de infecção não é nulo 

• Existe sempre a possibilidade de poderem ocorrer outras interferências RF  

 

Muito se tem discutido sobre os efeitos secundários da exposição dos seres humanos a 

radiações electromagnéticas. Estudos realizados concluem que existe uma pequena incidência de 

aumento de cancro nas pessoas mais expostas a essas radiações [3]. Existem no entanto, diversos 



 

tipos de radiação electromagnética, verificand

que se aumenta a frequência. Felizmente, a gama do espectro electromagnético correspondente 

aos sinais de radiofrequência (RF), ainda 

elevados níveis de energia (Raios

Actualmente o que se sabe é que os efeitos biológicos causados por RF são normalmente 

imperceptíveis, podendo no entanto provocar um aquecimento

pode levar à morte de células

 

1.3. Transmissão de energia

 

A telemetria médica sem fios, consiste na 

um paciente, utilizando tecnologia sem fios. 

aparelhos necessários para monitorizar o seu estado de saúde, possibilita ao paciente, uma maior 

mobilidade e conforto. O facto de poderem ser monitorizados vários pacientes ao mesmo tempo, 

diminui as despesas com a saúde [2].

O acoplamento indutivo, 

dispositivos implantados. Baseia

da outra.  

Figura 

 

Uma bobina encontra

bobina, que se encontra no exterior (emissor
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romagnética, verificando-se um aumento da energia de radiação à medida 

que se aumenta a frequência. Felizmente, a gama do espectro electromagnético correspondente 

aos sinais de radiofrequência (RF), ainda se encontra bastante distante de gamas que contêm 

ia (Raios-X, Raios-Gamma) que podem causar danos no ADN.

Actualmente o que se sabe é que os efeitos biológicos causados por RF são normalmente 

imperceptíveis, podendo no entanto provocar um aquecimento, que no caso de ser excessivo,

élulas [3].  

Transmissão de energia sem fios 

telemetria médica sem fios, consiste na monitorização remota do estado de saúde de 

um paciente, utilizando tecnologia sem fios. O facto de não ter que estar directamente ligado aos 

monitorizar o seu estado de saúde, possibilita ao paciente, uma maior 

mobilidade e conforto. O facto de poderem ser monitorizados vários pacientes ao mesmo tempo, 

diminui as despesas com a saúde [2]. 

O acoplamento indutivo, tem sido o principal meio utilizado para a comunicação com 

dispositivos implantados. Baseia-se no acoplamento magnético entre duas bobinas próxima

Figura 1.1: Simulação da transferência de energia 

encontra-se no implante (receptora) e recebe energia p

, que se encontra no exterior (emissora). Apesar de permitir a transmissão de informação 
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se um aumento da energia de radiação à medida 

que se aumenta a frequência. Felizmente, a gama do espectro electromagnético correspondente 

de gamas que contêm 

Gamma) que podem causar danos no ADN. 

Actualmente o que se sabe é que os efeitos biológicos causados por RF são normalmente 

no caso de ser excessivo, 

remota do estado de saúde de 

O facto de não ter que estar directamente ligado aos 

monitorizar o seu estado de saúde, possibilita ao paciente, uma maior 

mobilidade e conforto. O facto de poderem ser monitorizados vários pacientes ao mesmo tempo, 

zado para a comunicação com 

bobinas próximas uma 

 

e recebe energia proveniente de outra 

Apesar de permitir a transmissão de informação 
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entre o interior e o exterior, a sua utilização têm recaído primariamente na transferência de 

energia para o implante [4].  

Ao contrário dos sistemas de transmissão de informação sem fios que se baseiam na 

propagação de ondas electromagnéticas (far field), a transmissão de energia sem fios recorre ao 

acoplamento indutivo (near field) através do campo magnético. Embora os conceitos físicos 

envolvidos em ambas as topologias (far field e near field) estejam relacionados, na propagação de 

ondas electromagnéticas (far field) a percentagem da energia recebida só se torna crítica quando 

impossibilitar a recuperação com sucesso do sinal de informação (exemplo das ondas de rádio). A 

extracção de energia a partir do campo magnético incidente quando o receptor se encontra 

próximo do emissor (distância menor que ¼ do comprimento de onda) acaba por ser mais 

complexa pois os efeitos do campo próximo (near field) são mais significativos [34]. 

A utilização de acoplamento magnético para transmissão de energia, só é adequada a 

curtas distâncias entre as duas bobinas, devido ao facto de o campo magnético cair com r-3, sendo 

r a distância para a bobina emissora. Isto acontece devido ao facto de a bobina emissora radiar 

energia em diversas direcções caso não seja utilizado um material com propriedades magnéticas. 

A bobina receptora deve estar colocada perpendicularmente às linhas do campo magnético 

incidente, de forma a maximizar a energia recebida. A utilização de materiais magnéticos deve ser 

evitada, pois pode conduzir a efeitos adversos no indivíduo quando sujeito a um campo 

magnético exterior não desejado [4], tais como sensações de vertigem ou náusea, percepção de 

flashes de luz ou mesmo alterações ligeiras na pulsação. Felizmente, este tipo de sintomas só 

ocorre quando os campos magnéticos incidentes são superiores a 2Tesla [30]. 

Dependendo da distância entre as duas bobinas e da não utilização de materiais 

magnéticos (o que leva a que o acoplamento seja realizado utilizando o ar), facilmente se conclui 

que o coeficiente de acoplamento será muito baixo. Por esta razão, para que o implante receba a 

quantidade necessária de energia, a bobina emissora terá de fornecer um campo forte. 

Felizmente, às frequências utilizadas, os efeitos secundários que podem surgir são quase 

imperceptíveis e o risco para o paciente é mínimo. 

Tendo em conta que a dimensão dos sistemas são muito inferiores ao comprimento de 

onda utilizado, a análise dos sistemas pode ser descrita sem ter em conta a propagação de ondas, 

não sendo necessário recorrer a um modelo de elementos distribuídos para obter uma 

representação adequada do sistema.  

É possível distinguir sistemas que funcionam com acoplamento indutivo e sistemas com 

acoplamento capacitivo, mas praticamente todos os sistemas utilizam acoplamento indutivo, pois 
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como a constante dieléctrica do ar é muito baixa, é muito difícil utilizar o acoplamento capacitivo 

para a transmissão de energia sem fios [5]. 

 

1.4. Objectivos e Organização da Tese 

 

O objectivo principal deste trabalho consiste no estudo, desenho e posterior simulação de 

bobinas integradas em tecnologias CMOS convencionais. Pretende-se a optimização de bobinas 

integradas, de forma a maximizar a transferência de energia entre o emissor e o implante. Para o 

desenho e simulação utilizou-se um simulador de campo electromagnético de onda completa. 

A tese encontra-se organizada da seguinte maneira. O Capítulo 2 contém uma descrição 

das principais características das bobinas integradas. No Capitulo 3 apresenta-se o simulador de 

campo electromagnético utilizado, bem como uma breve descrição dos blocos funcionais 

necessários para proceder às simulações. No Capítulo 4 procede-se à verificação experimental dos 

resultados gerados pelo simulador, baseado nos resultados obtidos no projecto realizado em anos 

anteriores. No Capítulo 5 realiza-se um estudo sistemático de bobinas planares integradas, 

utilizando o simulador. No Capítulo 6 são desenhadas 2 bobinas, optimizadas para as frequências 

de 433MHz e 900MHz. No capítulo 7 procede-se à simulação de bobinas planares com a inclusão 

de patterned ground shields. No capítulo 8 procede-se à simulação da transmissão de energia 

utilizando como receptoras as bobinas optimizadas para 433MHz e 900MHz. As conclusões 

encontram-se no Capítulo 9. Em anexo encontra-se um tutorial de iniciação ao simulador de 

campo electromagnético utilizado. 
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2. Bobinas Planares Integradas 

 

2.1. Indutância e Bobinas 

 

As bobinas são utilizadas num elevado número de circuitos de Radiofrequência, 

nomeadamente circuitos ressonantes LC, filtros, LNA, VCO, etc. Contudo, a utilização de 

componentes passivos na forma integrada, especialmente em tecnologias de Silício, tem tido uma 

menor importância relativamente aos componentes activos. Um dos factores que mais contribuiu 

para essa desigualdade de interesses, tem a ver com o facto de os componentes passivos 

ocuparem uma área relativamente maior em comparação aos componentes activos, cujas 

dimensões tem vindo a ser sistematicamente reduzidas. Apesar de ser possível construir 

capacidades de baixo valor, a área necessária para construir uma bobina de determinado valor, 

acaba por ser elevada [7]. 

Quando um condutor é percorrido por uma corrente eléctrica variável, cria um campo 

magnético variável que dá origem a um fluxo magnético também variável. Esse fluxo magnético 

variável, ao atravessar o circuito fechado e de acordo com a Lei da Indução, dá origem a uma 

força electromotriz que, dependendo da resistência do circuito, produz uma corrente que vai 

produzir um campo que se opõe à passagem da corrente. Uma bobina é um componente passivo 

cuja principal função é armazenar energia sobre a forma de um campo magnético. A indutância L 

é a principal propriedade de uma bobina e é definida como a razão entre o fluxo magnético 

produzido e a corrente aplicada: 

� =  ϕ�  

 

onde I é a corrente aplicada em Amperes, Φ é o fluxo magnético em Wb e L é a indutância medida 

em H = Wb/A. A tensão aos seus terminais é: 

 

���	 = � ∗  ����	��  

 

enquanto a energia (Joules) armazenada é: 

 

� = 12 ∗ � ∗ �� 



 

As bobinas integrada

realizarem bobinas integrada

adjacentes de metal e às vias que interligam ess

bobina em solenóide ter as suas voltas alternando entre as 

leva a que tenha um baixo factor de qualidade devido à relativa alta resistividade das vias, entre 

outros factores [20].  

Grande parte da investigação desenvolvida, tem

bobinas integradas planares. A soluçã

realiza-la em espiral, como se pode verificar na figura seguinte.

 

 

 

A realização de uma bobina integrada

camadas de metal, sendo a

responsável por providenciar a ligação desde a volta interior até ao exterior. Como facilmente se 

percebe, vias serão utilizadas para estabelecer a conexão entre as diferentes camadas de metal
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tegradas são em grande parte planares. Existe a possibilidade de se 

bobinas integradas sem serem planares, normalmente recorrendo a 

adjacentes de metal e às vias que interligam essas camadas, realizando um solenó

ide ter as suas voltas alternando entre as várias camadas adjacentes de metal, 

a a que tenha um baixo factor de qualidade devido à relativa alta resistividade das vias, entre 

investigação desenvolvida, tem-se concentrado na optimização de 

. A solução encontrada para a realização da bobina planar consiste em 

em espiral, como se pode verificar na figura seguinte. 

Figura 2.1: Bobina Planar Circular 

uma bobina integrada em espiral, requer pelo menos a utilização d

sendo a bobina desenhada na camada superior e a camada inferior 

responsável por providenciar a ligação desde a volta interior até ao exterior. Como facilmente se 

percebe, vias serão utilizadas para estabelecer a conexão entre as diferentes camadas de metal

lson Miguel da Silva Ricardo 
s para Sistemas de Recolha de Energia sem Fios 

16 

s são em grande parte planares. Existe a possibilidade de se 

s sem serem planares, normalmente recorrendo a várias camadas 

as camadas, realizando um solenóide. O facto da 

camadas adjacentes de metal, 

a a que tenha um baixo factor de qualidade devido à relativa alta resistividade das vias, entre 

se concentrado na optimização de 

bobina planar consiste em 

 

em espiral, requer pelo menos a utilização de duas 

na camada superior e a camada inferior 

responsável por providenciar a ligação desde a volta interior até ao exterior. Como facilmente se 

percebe, vias serão utilizadas para estabelecer a conexão entre as diferentes camadas de metal. 



 

 

Quanto à forma, as bobinas integrada

figuras 2.3 e 2.4). A forma da bobina

forma circular. Ou seja, uma bobina

comprimento e área, logo, tem o maior valor de indu

formas. Uma bobina octogonal

longo face à circular [8]. No entanto, a

utilizada, pois muitos processos de circuitos integrados têm imposições de

utilizados. 

 

 

Underpass que 
permite a ligação 
ao exterior 
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Figura 2.2: Vias e Underpass 

bobinas integradas podem ser circulares, poligonais ou quadrada

da bobina, que para a mesma área tem o menor comprimento, é a 

bobina planar circular, tem o maior número de voltas para um dado 

logo, tem o maior valor de indutância, em comparação com as restantes

ogonal tem um perímetro 2.7% mais longo e uma quadrada

No entanto, a forma quadrada para a bobina integrada

pois muitos processos de circuitos integrados têm imposições de 90º face aos ângulos 

Figura 2.3: Bobina Planar Octogonal 
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dem ser circulares, poligonais ou quadradas (ver 

, que para a mesma área tem o menor comprimento, é a 

planar circular, tem o maior número de voltas para um dado 

tância, em comparação com as restantes 

quadrada 12.8% mais 

a bobina integrada é largamente 

90º face aos ângulos 

 

Vias para permitir 
a ligação entre as 
duas camadas de 
metal 



 

 

Existem ainda outras topologias utilizadas quanto a forma 

vezes é necessário estabelecer uma ligação num ponto arbitrário 

conexões habituais, por exemplo, em circuitos 

realizarem transformadores recorrendo a 

topologias não serão estudadas nesta dissertação.
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Figura 2.4: Bobina Planar Quadrada 

Existem ainda outras topologias utilizadas quanto a forma das bobinas integrada

vezes é necessário estabelecer uma ligação num ponto arbitrário da bobina 

conexões habituais, por exemplo, em circuitos diferenciais. Existe também a possibilidade de se 

realizarem transformadores recorrendo a bobinas integradas (ver figura 2.6)

topologias não serão estudadas nesta dissertação. 

Figura 2.5: Bobina Planar Simétrica 
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das bobinas integradas. Muitas 

 para além das duas 

. Existe também a possibilidade de se 

(ver figura 2.6). Contudo, estas 

 



 

Figura 2.6: Transformador Integrado (2 camadas de Metal)

 

Uma bobina em espiral pode ser construída

um mínimo de 2 camadas de metal, como já foi referido. No desenho de 

entramos em conta com dois tipos de parâmetros: parâmetros tecnológicos e parâmetros de 

desenho. 

Os parâmetros tecnológicos são responsáveis

performance da bobina. Os parâmetros tecnológicos têm 

respeita à resistividade do substrato, espessura

sendo, o projectista tem uma influê

influência dos parâmetros tecnológicos será estudada em secções seguintes.

Os parâmetros de desenho

sendo o valor da indutância maioritar

parâmetros de desenho são: 

• Largura do Metal (W)

• Espaçamento entre espiras (S)

• Diâmetro interior (D

• Diâmetro exterior (D

• Número de Voltas (N)
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Figura 2.6: Transformador Integrado (2 camadas de Metal) 

bobina em espiral pode ser construída nas tecnologias CMOS actuais r

um mínimo de 2 camadas de metal, como já foi referido. No desenho de 

entramos em conta com dois tipos de parâmetros: parâmetros tecnológicos e parâmetros de 

s tecnológicos são responsáveis em grande parte, mas não totalmente

Os parâmetros tecnológicos têm a ver com a tecnologia utilizada, no que 

respeita à resistividade do substrato, espessura, tipo e resistividade do metal entre outros. Assim 

sendo, o projectista tem uma influência limitada no que respeita aos processos tecnológicos. 

influência dos parâmetros tecnológicos será estudada em secções seguintes. 

Os parâmetros de desenho são os parâmetros em que o projectista tem maior controlo, 

sendo o valor da indutância maioritariamente decidido pelos parâmetros de desenho. Os 

 

Largura do Metal (W) 

Espaçamento entre espiras (S) 

Diâmetro interior (Din) 

Diâmetro exterior (Dout) 

Número de Voltas (N) 
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nas tecnologias CMOS actuais recorrendo a 

um mínimo de 2 camadas de metal, como já foi referido. No desenho de bobinas planares, 

entramos em conta com dois tipos de parâmetros: parâmetros tecnológicos e parâmetros de 

mas não totalmente, pela 

a tecnologia utilizada, no que 

tividade do metal entre outros. Assim 

ncia limitada no que respeita aos processos tecnológicos. A 

 

são os parâmetros em que o projectista tem maior controlo, 

iamente decidido pelos parâmetros de desenho. Os 
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Figura 2.7: Características de desenho da bobina planar 

 

Devido ao facto de serem os parâmetros de desenho que acabam por influenciar 

maioritariamente o valor da indutância, conjuntamente com o facto de o projectista ter pouca 

influência sobre os parâmetros tecnológicos, uma das formas de maximizar o desempenho da 

bobina para uma determinada tecnologia CMOS, consiste na optimização dos parâmetros de 

desenho. 

Usando os parâmetros acima apresentados, diversas fórmulas foram desenvolvidas com o 

intuito de calcular de forma rápida, o valor da indutância de bobinas em espiral. Essas expressões 

apresentam um erro de cerca de 3% quando comparadas com os resultados obtidos em 

simuladores de campo 3D [9]. Existe também online uma página que permite calcular o valor da 

indutância para bobinas planares quadradas, circulares ou octais, para qualquer uma das três 

fórmulas apresentadas seguidamente. 

O site encontra-se em http://smirc.stanford.edu/spiralCalc.html e apresenta uma 

interface bastante amigável. 

Para o cálculo da Indutância usando as três fórmulas seguintes, teremos previamente que 

definir 2 expressões que serão usadas posteriormente: 

 

• Raio médio (Davg) 

���� = ��� + ����2  
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• Rácio de preenchimento (ρ) 

� =  ���� − ������� + ��� 

 

As fórmulas utilizadas para o cálculo do valor da Indutância são: 

• Fórmula de Wheeler Modificada 

  

��� = �� ∗ µ! ∗ "� ∗ ����1 + �� ∗ � 

 

Com K1 = 2.43 e K2 = 2.75 para uma bobina quadrada. 

 

• Aproximação Current Sheet 

 

���# = µ ∗ "� ∗ ���� ∗ $�2 ∗ %&" %$�� ' + $( ∗ � + $) ∗ ��' 

 

Com c1 = 1.27, c2 = 2.07, c3 = 0.18, c4 = 0.13 para uma bobina quadrada. 

 

• Expressão Monomial Fit 

 

���� = * ∗ �����+ ∗ ,�- ∗ �����. ∗ "�/ ∗ 0�1  

 

Com β = 1.62 * 10-3, a1 = -1.21, a2 = -0.147, a3 = 2.4, a4 = 1.78, a5 = -0,03 para uma bobina 

quadrada. 

 

2.2. Factor de Qualidade (Q) 

 

O factor de qualidade (Q) é, juntamente com a frequência de ressonância (fres), uma das 

figuras de mérito de uma bobina. Especialmente importante é o valor máximo do factor de 

qualidade (Qmax) e a frequência a que esse valor ocorre (fmax). 

O factor de qualidade é importante na caracterização de elementos passivos, 

principalmente de bobinas, pois são estas mesmas as que mais se desviam do modelo ideal. Por 
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esta razão, o desempenho de circuitos que utilizam bobinas é em grande medida, directamente 

proporcional ao factor de qualidade da bobina. Num circuito ressonante LC, a bobina é o 

componente crítico. Num oscilador o ruído de fase e o consumo de potência são extremamente 

dependentes do factor de qualidade da bobina. Contudo, existem circuitos em que também a 

frequência de ressonância da bobina desempenha um papel crucial, pois perto dessa frequência, 

o comportamento desvia-se bastante do desejado para uma bobina. 

O factor de qualidade pode ser definido genericamente como: 

 

2 = 2 ∗ 3 ∗ �"45678 8598:4"8�8�"45678 �7007;8�8 "<9 $7$&= �4 =0$7&8çã= 

 

A definição de factor de qualidade apresentada anteriormente é genérica, pois não define 

qual o dispositivo que armazena ou dissipa energia. A distinção que se pode efectuar entre o Q de 

diversos dispositivos, reside no facto de que tipo de energia é armazenada e dissipada. No caso de 

uma bobina, só a energia armazenada sobre a forma de campo magnético é importante, daí que 

qualquer armazenamento de energia sob a forma de campo eléctrico é indesejável. O Q é então 

proporcional à diferença de energia de pico magnética (devido ao campo magnético) e eléctrica 

(devido ao campo eléctrico). 

 

2 = 2 ∗ 3 ∗ @�"45678 �4 A7$= B86"é�7$8 − �"45678 �4 A7$= �&é$�57$8@�"45678 �7007;8�8 "<9 $7$&= �4 =0$7&8çã=  

 

Quando as energias de pico, quer magnética quer eléctrica, são iguais, a bobina encontra-

se na frequência de ressonância, logo o seu Q = 0 a essa frequência. Pela análise da equação 

anterior, conclui-se que o factor de qualidade pode ser maximizado, minimizando quer a energia 

sobre a forma de campo eléctrico armazenada, quer reduzindo as perdas por dissipação de 

energia. 

No caso de um circuito de tanque LC, a equação genérica para o factor de qualidade 

também pode ser aplicada, só que neste caso, a energia armazenada é a soma das energias 

eléctricas e magnéticas médias. 
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Recorrendo ao modelo equivalente da bobina integrada que se apresentará na secção 2.4 

onde Ls é indutância série; Rs é resistência série; Cs é a capacidade série; Csi é a capacidade do 

substrato; Rsi é a resistência do substrato; Cox é a capacidade existente entre a bobina e o 

substrato, e de acordo com o desenvolvido em [29], o factor de qualidade Q para uma bobina 

integrada é definido como: 

 

2 = D ∗ �EFE ∗ FEGFEG + H�D ∗ �E /FE	� + 1J ∗ FE ∗ K1 − FE� ∗ �LEG + LE	�E − MD� ∗ �E ∗ �LEG + LE	NO 

 

A primeira parte desta equação representa a energia armazenada sobre a forma de 

campo magnético e as perdas resistivas. A segunda parte desta equação diz respeito às perdas 

que ocorrem no substrato responsáveis pela degradação do factor de qualidade a altas 

frequências. O terceiro factor desta equação caracteriza a frequência de ressonância da bobina. A 

partir destes factores podemos definir uma equação geral para o factor de qualidade de uma 

bobina integrada como sendo: 

 

2 = D ∗ �EFE ∗ P8$�=5 �4 ;45�80 "= 0<Q0�58�= ∗ P8$�=5 �4 5400="â"$78 �8 Q=Q7"8 

 

2.3. Mecanismos de Perdas 

 

Tendo a bobina a principal função de armazenar energia sobre a forma de um campo 

magnético, a capacidade e resistência que existem nas bobinas reais são elementos parasitas que 

degradam o desempenho da bobina. 

Às baixas frequências, podem-se emular bobinas recorrendo a componentes activos, 

aumentando assim o nível de integração. Contudo, as bobinas integradas fabricadas em substrato 

de Silício que operam a altas frequências, acabam por ter baixos factores de qualidade devido ao 

facto de ocorrerem perdas no metal e perdas no substrato. As perdas no metal, devem-se ao 

facto de o metal utilizado apresentar uma determinada resistência, ao skin effect e a irregulares 

distribuições de corrente na bobina que o campo magnético pode provocar. As perdas no 

substrato têm a ver com a sua baixa resistividade utilizada nos processos actuais, que permite a 

formação de correntes parasitas que aumentam as perdas resistivas no substrato e atenuam o 

campo magnético, levando a uma redução da indutância [9]. É importante perceber os 
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mecanismos de perdas que ocorrem nas bobinas planares integradas para proceder à 

maximização do factor de qualidade para uma dada frequência e tecnologia. 

 

2.3.1. Perdas no substrato causadas pelo Campo Eléctrico 

 

Geralmente o substrato está ligado a um potencial de referência (normalmente designado 

“massa”), o que origina um campo eléctrico entre o substrato e as espiras da bobina. Surge então 

um acoplamento capacitivo entre o substrato e a bobina, devido a essa diferença de potencial 

(ver figura 2.8). 

 

Figura 2.8: Campo Eléctrico a penetrar no substrato 

 

O facto de o campo eléctrico penetrar no substrato condutivo, origina perdas ohmicas. O 

total das perdas no substrato depende da dopagem do mesmo (associado à sua resistividade), da 

área ocupada pela bobina, da distância entre o substrato e a bobina e da frequência de operação 

[17]. 

 

2.3.2. Skin effect e efeito de proximidade 

 

O skin effect ou efeito pelicular, é um fenómeno que ocorre com o aumento da frequência 

e que leva a uma distribuição não uniforme da corrente num condutor. Com o aumento da 

frequência, a corrente passa a circular maioritariamente junto das superfícies do condutor devido 

à formação de correntes parasitas (correntes de Foucault). As correntes parasitas manifestam-se 

através do efeito pelicular e do efeito de proximidade. De acordo com a Lei de Faraday, as 

correntes parasitas surgem quando um condutor está sujeito a um campo magnético variável no 

Linhas do Campo 
Eléctrico 
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tempo. De acordo com a Lei de Lenz, as correntes parasitas originam campos magnéticos que se 

opõem ao campo inicial. No caso do efeito pelicular, o campo magnético criado pela passagem da 

corrente pelo condutor, cria no próprio condutor correntes parasitas. A secção transversal do 

condutor responsável pela passagem da corrente, diminui então com o aumento da frequência, 

levando a um aumento da resistência do condutor e a um consequente aumento das perdas 

ohmicas. 

O efeito de proximidade ocorre quando um condutor encontra-se sobre o efeito de um 

campo magnético variável, criado por um outro condutor que se encontra próximo do primeiro 

condutor. Neste caso, quer circule ou não uma corrente no condutor que está sobre a influência 

do campo, surgem neste mesmo condutor correntes parasitas. No caso de o condutor que está 

sob a influência do campo magnético variável circular uma corrente, verifica-se o surgimento de 

correntes parasitas quer devido ao efeito peculiar quer ao efeito de proximidade, sendo 

extremamente difícil distinguir a influência de cada componente.  

Quer o efeito pelicular quer o efeito de proximidade, aumentam a resistência AC do 

condutor, verificando-se que o efeito pelicular acaba por exercer uma grande influência na 

distribuição da corrente.  

No caso das bobinas em espiral, devido á proximidade entre os diversos segmentos que 

compõem a bobina, a corrente que circula em cada segmento pode induzir a criação de correntes 

parasitas e levar a um aumento da resistência AC. 

O efeito pelicular ou skin depth é definido como: 

 

S = T �3 ∗ U ∗ P 

 

com µ, ρ, f representando a permeabilidade (H/m), resistividade (Ω/m) e frequência (Hz), 

respectivamente. 

O efeito das correntes parasitas pode ser omitido, se o efeito pelicular for muito maior 

que a espessura do condutor [16]. 

 

2.3.3. Perdas no substrato causadas pelo Campo Magnético 

 

Outro dos mecanismos de perdas que se verifica nas bobinas integradas, é a interacção 

existente entre o campo magnético criado pela bobina e o substrato. O campo magnético variável 
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que penetra no substrato, potencia o surgimento no mesmo de correntes parasitas 

magneticamente induzidas, que por sua vez, levam a um decréscimo do factor de qualidade 

devido à dissipação de potência que causam. As correntes parasitas induzidas no substrato, por 

sua vez, criam elas próprias um campo magnético variável que se vai opor ao campo original, o 

que tem como consequência uma redução do valor da Indutância (ver figura 2.9).  
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Figura 2.9: Linhas do Campo Magnético a penetrar no substrato 

 

 

2.3.4. Diminuição de perdas em bobinas planares integradas 

 

Os efeitos causados pelo Campo Eléctrico entre o substrato e a bobina, podem ser 

atenuados de diferentes formas. Contudo, grande parte das soluções apresentadas, consistem em 

alterações na estrutura da tecnologia utilizada, o que acaba por aumentar grandemente o custo 

de produção. Exemplos de soluções que recorrem a estas alterações são: 

• A remoção do substrato que se encontra por baixo da bobina 

• A construção de bobinas integradas suspensas 

• Alteração da dopagem do substrato que se encontram por baixo da bobina 

 

Uma das soluções largamente utilizada consiste na construção de uma placa ligada à 

massa (Patterned Ground Shield - PGS) entre a bobina e o substrato, recorrendo à primeira 

camada de metal ou à camada de polisilício, sendo portanto, uma técnica que não aumenta o 

custo do chip. Graças à placa adicional, o Campo Eléctrico é terminado antes de penetrar no 



 

substrato, diminuindo as perdas 

mais baixa (ver figura 2.10). 

Figura 2.10: Campo Eléctrico terminado antes de chegar 

 

Infelizmente, a introdução de 

Como podem ser induzidas correntes na placa com direcção oposta à que lhe deu origem, levando 

a uma redução do valor da Indutância devido ao 

dividida em secções 

Como é necessário estabelecer uma conexão entre as diversas secções do escudo, deve

se prestar especial atenção para que não se formem 

 

Figura 2.1

 

Nélson Miguel da Silva Ricardo
Indutores Integrados para Sistemas de Recolha de Energia sem 

uindo as perdas uma vez que é implementado num material com resistividade 

Óx
id
o

PGS

Su
bs
tra
to

 

: Campo Eléctrico terminado antes de chegar ao substrato graças ao PGS

Infelizmente, a introdução de um PGS aumenta o valor da capacidade parasita 

podem ser induzidas correntes na placa com direcção oposta à que lhe deu origem, levando 

a uma redução do valor da Indutância devido ao acoplamento indutivo negativo

Como é necessário estabelecer uma conexão entre as diversas secções do escudo, deve

se prestar especial atenção para que não se formem loops de corrente no escudo.

Figura 2.11: Exemplo de escudo (Patterned Ground Shield) 
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uma vez que é implementado num material com resistividade 

ao substrato graças ao PGS 

alor da capacidade parasita da bobina. 

podem ser induzidas correntes na placa com direcção oposta à que lhe deu origem, levando 

acoplamento indutivo negativo, esta deve ser 

Como é necessário estabelecer uma conexão entre as diversas secções do escudo, deve-

de corrente no escudo.  
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Diferentes tipos de escudos foram estudos em [19]. Com base neste trabalho, é 

importante referir que o escudo deve ser conectado à massa em dois pontos diametralmente 

opostos para que não se verifique um comportamento assimétrico do factor de qualidade. O 

espaçamento entre as diversas secções do escudo deve ser mantido relativamente curto para que 

o Campo Eléctrico vertical não penetre no substrato. 

Infelizmente, o escudo não consegue atenuar a interacção entre o substrato e o campo 

magnético. Essa atenuação pode ser conseguida removendo o substrato que se encontra por 

baixo da bobina ou afastando a bobina do substrato através de uma construção suspensa. 

Contudo, como se tratam de técnicas que aumentam largamente o custo de produção, não serão 

estudadas nesta dissertação. 

Outra das soluções correntemente adoptadas para melhorar o comportamento da bobina 

integrada, consiste na utilização de 2 camadas adjacentes de metal interligadas por vias para o 

desenho da bobina. A utilização desta técnica requer pelo menos a utilização 3 camadas de metal, 

duas para as bobinas emparelhadas e uma para a ligação da volta interior da bobina ao exterior 

(underpass). 

A grande vantagem da utilização desta técnica, está no facto de se aumentar a 

condutividade da bobina, que resulta numa melhoria considerável do seu factor de qualidade, 

mas para isso é necessário que se utilize um elevado número de vias para proceder ao 

emparelhamento das duas camadas de metal. Contudo, é preciso ter em conta que a bobina e o 

underpass se encontram mais próximos do substrato o que leva a um aumento da capacidade 

existente entre a bobina e o substrato. 

No caso de a tecnologia utilizada permitir, ainda se podem interligar mais camadas de 

forma a reduzir a resistência da bobina, mas um estudo comparativo entre os benefícios da 

redução da resistividade do metal e os prejuízos causados pelo aumento da capacidade deve ser 

realizado, tendo em vista os objectivos pretendidos. 

 

2.4.  Modelo Eléctrico de uma Bobina Planar Integrada 

 

O modelo equivalente de um dispositivo, é uma ferramenta importante para a análise de 

circuitos que incluem esse mesmo dispositivo, principalmente quando se usa software para 

realizar essa análise. A bobina integrada, sendo o dispositivo passivo que mais se afasta do 

modelo ideal, é o dispositivo cujo modelo equivalente apresenta maiores problemas. A DC, os 

valores dos diferentes elementos do modelo equivalente, são relativamente fáceis de se extrair. 
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Contudo, a altas frequências, uma predição dos seus valores continua a ser um desafio, devido a 

todos os fenómenos de alta frequência que podem ocorrer. A chave para a construção de um 

modelo realista está na capacidade de perceber antecipadamente todos os efeitos que podem 

ocorrer a altas frequências. 

A imagem seguinte apresenta um corte transversal duma bobina integrada, onde se 

destacam os elementos que compõem o seu modelo equivalente. 
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Figura 2.12: Modelo Eléctrico da Bobina Planar Integrada 

 

A indutância e a resistência da bobina são representadas pela indutância série Ls e a 

resistência série Rs. A sobreposição existente entre as espiras da bobina e o underpass induzem 

um acoplamento capacitivo entre os dois terminais da bobina e é representado pela capacidade 

série Cs. A capacidade criada pelo óxido entre a bobina e o substrato é modelada pela capacidade 

Cox. A capacidade e resistividade do substrato de silício são modeladas pela capacidade Csi e pela 

resistência Rsi, respectivamente. 
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A resistência série Rs, é dependente da frequência devido ao efeito pelicular e ao efeito de 

proximidade. Como já foi referido anteriormente, ambos os efeitos são aditivos e dificilmente se 

conseguem distinguir individualmente os efeitos causados por cada uma das contribuições. Uma 

estimativa da resistência série Rs pode ser calculada recorrendo a uma equação definida em [27], 

que se apresenta seguidamente: 

FE ≈ &, ∗ W ∗ S�1 − 4X� YZ 	 

 

onde W é a condutividade do condutor, S é o efeito pelicular, l é o comprimento total do 

condutor, w é a largura da pista e t a espessura do condutor. 

 

A capacidade série Cs, modela o acoplamento capacitivo entre os dois terminais da 

bobina. Este acoplamento capacitivo, permite que o sinal injectado num dos terminais passe 

directamente para o outro terminal, sem percorrer a bobina. Este tipo de acoplamento capacitivo 

tanto pode ocorrer entre a bobina e o underpass como entre as voltas adjacentes da espiral. No 

caso das voltas adjacentes, como se encontram aproximadamente ao mesmo potencial, a sua 

contribuição para Cs é baixa. O efeito é mais acentuado entre a bobina e o underpass devido à 

diferença de potencial entre ambos [21] [22]. Em [16] e [27], CS é definido como: 

 

LE = " ∗ ,� ∗ [�\���,� 

 

onde n é o número de voltas, w é a largura da pista, [ox é a permitividade do óxido e tm1,2 é a 

distância existente entre a camada de metal onde está o underpass e a camada de metal utilizada 

para a bobina. 

 

A origem física de Rsi está relacionada com a condutividade do substrato, sendo 

dependente da dopagem do mesmo. Csi representa os efeitos capacitivos que ocorrem no 

semicondutor a altas frequências. No geral, Cox, Rsi e Csi modelam as características de estruturas 

microstrip em silício [16].  
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A capacidade existente entre a bobina e o substrato é representada por Cox, cujo valor é 

aproximado ao de um condensador de placas paralelas. Em [16] e [27], Cox é definido como: 

 

L^_ = 12 ∗ & ∗ , ∗ [�\��\  

 

onde l é o comprimento total do condutor, w é a largura da pista, [ox é a permitividade do óxido e 

tox é a espessura da camada de óxido. O factor de 2 advém do facto de se assumir que os efeitos 

parasitas no substrato, estão igualmente distribuídos pelos dois terminais da bobina. 

 

A resistência Rsi e a capacidade Csi é definida na literatura [16] e [27] como sendo: 

 

FEG = 2& ∗ , ∗ `a�b 

 

LEG = 12 ∗ & ∗ , ∗ La�b 

 

onde l é o comprimento total do condutor, w é a largura da pista, Gsub é condutância do substrato 

por unidade de área, Csub é a capacidade do substrato por unidade de área. Mais uma vez, o factor 

de 2 em ambas as expressões, advêm do facto de se assumir que os efeitos parasitas no 

substrato, estão igualmente distribuídos pelos dois terminais da bobina. 
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3. Simulador de Campo Electromagnético 

 

3.1. Cumputed-aided Design 

 

O aumento do interesse que se tem verificado nos últimos anos por sistemas de 

comunicação sem fios e no sector das comunicações móveis, tem impulsionado o 

desenvolvimento desses mesmos sistemas, proporcionado desafios constantes aos projectistas 

dos circuitos. O balanço entre a performance do circuito e os custos de produção, é algo com que 

os projectistas têm de lidar no seu dia-a-dia, o que pode levar a mudanças na metodologia de 

desenho e teste do circuito, na procura do melhor compromisso. 

Devido às altas frequências de operação deste tipo de circuitos, as dimensões do mesmo 

são muitas vezes da mesma ordem de grandeza do comprimento de onda de operação. Isto em 

conjunção com o facto de cada vez mais o número de componentes adjacentes no mesmo 

substrato aumentar, leva a que uma análise teórica do comportamento do circuito usando 

elementos distribuídos seja difícil, obrigando ao uso de software apropriado para a análise do 

comportamento deste tipo de circuitos. 

O tipo de software utilizado para a análise do comportamento deste tipo de circuitos 

pode ser dividido em dois grandes grupos: Esquemático e Simuladores de Campo 

Electromagnético. O primeiro tipo de software, Esquemático, apresenta-nos diversas bibliotecas 

com vários tipos de elementos, a partir dos quais, podemos construir o nosso circuito através da 

interligação desses elementos. Neste tipo de software, as simulações são normalmente rápidas, 

em comparação com as realizadas em Simuladores de Campo Electromagnético, mas não 

providenciam uma análise electromagnética de onda completa, sendo a simulação do circuito 

realizada com recurso a equações que normalmente têm uma gama de utilização restrita, sendo 

portanto um tipo de software útil para quando se pretende obter um conhecimento aproximado 

do comportamento do circuito ou são apenas utilizados circuitos já certificados pela praxis. Por 

outro lado, os Simuladores de Campo Electromagnético de onda completa, utilizam diversas 

técnicas, que variam de software para software, para resolver as equações de Maxwell. Entre as 

diferentes técnicas destacam-se o Método dos Elementos Finitos e o Método dos Momentos. Os 

Simuladores de Campo Electromagnético de onda completa, quando usados correctamente, 

fornecem resultados bastante exactos [10]. 

O já referido aumento do interesse verificado nas tecnologias da comunicação, 

nomeadamente as comunicações móveis e dispositivos de consumo de baixo custo, leva a que 
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cada vez mais empresas apostem no desenvolvimento dos seus produtos, tendo em mente a 

melhoria da relação preço/qualidade, o que leva a uma tentativa de diminuição dos custos de 

produção, mantendo a performance. A tecnologia CMOS é actualmente a única capaz de reunir 

essas condições do custo de produção, tendo a capacidade de integrar módulos funcionais 

analógicos e digitais num mesmo chip. Contudo, a falta de materiais magnéticos nos processos 

standards actuais, dificulta o desenvolvimento do circuito ressonante, nomeadamente a bobina 

receptora, que se pretende construir.  

A bobina receptora será responsável por grande parte da área ocupada no chip, sendo o 

factor de qualidade do circuito receptor grandemente influenciado pelo factor de qualidade da 

bobina. Como pretendemos obter o melhor factor de qualidade possível para a bobina usando a 

tecnologia CMOS disponível, o fabrico de diversas bobinas variando o espaçamento entre pistas, a 

largura das pistas e o raio interior da bobina, de forma a escolher a melhor bobina, é uma 

abordagem ao problema que iria aumentar largamente o do custo do projecto. Por isso mesmo e 

tendo em conta os resultados obtidos em outras investigações [11] em que se procedeu à 

comparação entre bobinas simuladas e fabricadas, a abordagem utilizada para o desenho da 

bobina foi a utilização de um simulador de campo electromagnético de onda completa. O 

simulador de campo electromagnético de onda completa, apesar de necessitar de um tempo de 

simulação elevado em comparação com outras ferramentas, quando configurado correctamente, 

produz resultados muito semelhantes aos obtidos através de medições. Desta forma podemos 

proceder à simulação de diversas bobinas, de forma a dimensionar a bobina ideal para o nosso 

projecto, obtendo uma boa estimativa do comportamento real dessas bobinas. O simulador 

utilizado foi o Ansoft HFSS [31] que é um simulador de campo electromagnético de onda 

completa, que utiliza o Método dos Elementos Finitos para resolver as Equações de Maxwell. 

 

3.2. HFSS: método dos elementos finitos 

 

HFSS é um simulador de campo electromagnético 3D de onda completa que permite o 

cálculo do campo electromagnético no interior de diversas estruturas passivas de volumes 

arbitrários. Para gerar uma solução do campo electromagnético, HFSS usa o Método dos 

Elementos Finitos (MEF). 

O MEF é uma técnica numérica para resolver equações diferenciais parciais que 

descrevem o comportamento de sistemas físicos, que tem se tornado numa ferramenta 

importante para resolver diversos projectos de engenharia [12]. No geral, o MEF divide todo o 
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espaço do problema em milhares de regiões e representa o campo em cada sub-região com uma 

função local. Ao conjunto dessas sub-regiões dá-se normalmente o nome de malha. 

O simulador utilizado divide automaticamente o domínio do problema, em diversas sub-

regiões que neste caso são tetraedros, formando a chamada malha de elementos finitos. Os 

tetraedros são formados por quatro faces, sendo cada face um triangulo equilátero. Em cada 

vértice do tetraedro, o simulador armazena as componentes do campo (quer eléctrico quer 

magnético) que são tangenciais às três arestas do tetraedro que convergem para esse vértice. A 

meio de cada aresta, o simulador volta a armazenar a componente do campo que é normal a essa 

mesma aresta e tangencial às faces do tetraedro. Na imagem seguinte pode observar em detalhe 

os pontos onde são armazenados os valores dos campos em cada tetraedro. 

 

 

 

 

 

 

Interpolando os diversos valores obtidos, é possível calcular o campo no interior do 

tetraedro. Com recurso a esta técnica, o simulador consegue calcular distribuições 3D dos 

campos, consegue prever grande parte de efeitos que ocorrem a altas frequências (dispersões, 

radiações, perdas), porque consegue transformar o cálculo contínuo do valor do campo usando as 

Equações de Maxwell, numa serie de equações algébricas que podem ser resolvidas com recurso 

a métodos matriciais. 

 

 

 

 

As componentes do campo que são tangenciais às 

arestas, são armazenadas nos vértices 

Em cada aresta são armazenadas as componentes 

simultaneamente normais às arestas e tangenciais 

às faces do tetraedro 

A partir dos valores nodais calculados 

anteriormente, o HFSS calcula o campo no interior 

do tetraedro  



Nélson Miguel da Silva Ricardo 
Indutores Integrados para Sistemas de Recolha de Energia sem Fios 

36 

 

3.3. HFSS: processo para gerar a solução 

 

Existe um compromisso entre os recursos computacionais disponíveis, o nível de precisão 

que pretendemos e o número de elementos (tetraedros) que compõem a malha.  

A precisão desejada é largamente dependente do tamanho dos elementos da malha, ou 

seja, é dependente do número de elementos da malha. Para se obter uma descrição precisa do 

comportamento do campo, é necessário que cada elemento ocupe uma região suficientemente 

pequena para que o campo seja adequadamente interpolado a partir dos valores nodais obtidos 

para cada tetraedro. Ou seja, soluções que recorram a um elevado numero de elementos vão ser 

mais precisas que outras que recorram a poucos elementos. Como facilmente se percebe, quanto 

mais elementos tiver a solução, maior será o esforço computacional necessário, quer em 

capacidade de processamento quer em memória, para poder gerar a solução. Felizmente, o 

simulador usa um processo iterativo denominado de análise adaptativa, no qual após a geração 

da malha inicial, essa mesma malha é refinada em certas regiões críticas onde existe uma elevada 

densidade de erros. 

Após ter gerado a solução a uma ou várias frequências, o simulador fornece como 

resultados imediatos as matrizes de parâmetros S, Y, Z e ABCD. A matriz dos parâmetros S obtida, 

basicamente reduz a complexidade do comportamento electromagnético da estrutura a um 

conjunto de parâmetros de alta frequência. Para calcular essa matriz, o simulador realiza os 

seguintes passos: 

• Divide a estrutura numa malha composta por um número de elementos finitos, 

denominada de manha inicial. 

• Em cada porta da estrutura (local onde são aplicados os sinais de excitação na 

estrutura a ser simulada), calcula os modos que podem existir numa linha de 

transmissão cuja secção transversal tem as mesmas dimensões que a da porta. 

• Calcula a totalidade do campo electromagnético dentro da estrutura, de modo a 

satisfazer as condições impostas por cada porta. 

• Através da relação entre a potência transmitida e reflectida, é calculada a matriz dos 

parâmetros S. 
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O fluxograma seguinte explica simplificadamente como o simulador procede para gerar a 

malha de elementos: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Convém referir o seguinte: 

• Se tiverem sido definidas opções para refinar a malha, essas opções podem ser 

aplicadas aquando da criação da malha inicial ou após a criação desta, dependendo 

do tipo de operações previamente definidas. 

• Se tiver sido definida uma análise adaptativa, o simulador refina os tetraedros nas 

regiões onde se verifica um maior erro, parando o processo iterativo acima descrito 

quando algum critério de convergência previamente definido for atingido ou quando 

o máximo número de passos adaptativos for atingido. 

• Se um varrimento na frequência for solicitado, o simulador utiliza a malha refinada 

obtida na frequência da solução predefinida (fsolução) para calcular os valores para as 

Testa a exactidão do 
sinal de excitação em 
cada porta comparando 

∇H com E e ∇E com H 

HFSS gera uma malha 
inicial 

Calcula o padrão de 
excitação para cada 
porta para f = fsolução 

Resultado 
aceitável? 

Refinamento da malha 
2D nas portas 

Calcula os campos 
electromagnéticos 
dentro da estrutura, 
usando o refinamento 
anterior da malha 2D 
das portas de excitação, 
para f = fsolução 

Refinamento da malha 
dentro da estrutura 

Calcula a matriz dos 
parâmetros S para           
f = fsolução 

∆S 
aceitável? 

Realiza a análise em diversas frequências, caso tenha 
sido pedido 

Matriz dos parâmetros S fica disponível, bem como as 
diversas distribuições dos diferentes campos.  

S

S

N

N



 

outras frequências, não procedendo ao refinamento da malha para as restantes 

frequências. 

 

Um exemplo de uma estrutura antes e depois de ser gerada a malha de elementos 

encontra-se nas imagens seguintes:
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outras frequências, não procedendo ao refinamento da malha para as restantes 

Um exemplo de uma estrutura antes e depois de ser gerada a malha de elementos 

se nas imagens seguintes: 

Figura 3.1: Estrutura antes de ser criada a malha 

Figura 3.2: Estrutura após ser criada a malha 
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outras frequências, não procedendo ao refinamento da malha para as restantes 

Um exemplo de uma estrutura antes e depois de ser gerada a malha de elementos 

 

 



 

3.4. HFSS: estrutura de simulação

 

Para proceder à simulação de estruturas passivas no HFSS, é necessário acrescentar uma 

série de blocos virtuais aos blocos físicos que constituem a estrutura a ser simulada. 

pretendemos simular diversa

radiação (air box), portas de excitação da estrutura (

(perfect-E bars). Esses blocos vir

 

Figura 3.3

 

No HFSS, todas as superfícies que 

simultaneamente fazem fronteira com o plano de fundo do programa (

automaticamente definidas pelo mesmo como 

(perfect-E boundaries). O vector campo eléctrico é assumido como sendo normal a essas 

superfícies, levando a que a solução final do campo tenha que ter uma componente

nula nessas superfícies, impedindo que nenhuma energia entre ou deixe a estrutura. 

este facto, é necessário definir um bloco virtual

automaticamente como superfícies de um condutor perfeito. Esse bloco é uma 

Superfície 
de radiação 

Condutor 
Perfeito 
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estrutura de simulação 

Para proceder à simulação de estruturas passivas no HFSS, é necessário acrescentar uma 

série de blocos virtuais aos blocos físicos que constituem a estrutura a ser simulada. 

pretendemos simular diversas bobinas, os blocos virtuais necessários foram a 

), portas de excitação da estrutura (lumped ports) e condutores perfeitos 

Esses blocos virtuais encontram-se destacados na imagem seguinte.

Figura 3.3: Blocos virtuais necessários para simular bobinas 

No HFSS, todas as superfícies que compõem a estrutura que pretendemos simular 

fazem fronteira com o plano de fundo do programa (

automaticamente definidas pelo mesmo como sendo superfícies de um condutor perfeito

. O vector campo eléctrico é assumido como sendo normal a essas 

superfícies, levando a que a solução final do campo tenha que ter uma componente

superfícies, impedindo que nenhuma energia entre ou deixe a estrutura. 

este facto, é necessário definir um bloco virtual cujas suas faces vão ser definidas 

automaticamente como superfícies de um condutor perfeito. Esse bloco é uma 
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Para proceder à simulação de estruturas passivas no HFSS, é necessário acrescentar uma 

série de blocos virtuais aos blocos físicos que constituem a estrutura a ser simulada. Como 

, os blocos virtuais necessários foram a superfície de 

) e condutores perfeitos 

se destacados na imagem seguinte. 

 

a estrutura que pretendemos simular e que 

fazem fronteira com o plano de fundo do programa (background), são 

sendo superfícies de um condutor perfeito 

. O vector campo eléctrico é assumido como sendo normal a essas 

superfícies, levando a que a solução final do campo tenha que ter uma componente tangencial 

superfícies, impedindo que nenhuma energia entre ou deixe a estrutura. Devido a 

cujas suas faces vão ser definidas 

automaticamente como superfícies de um condutor perfeito. Esse bloco é uma “caixa de ar” que 

Portas de 
excitação 



 

envolve toda a estrutura e que assim permite investigar o comportamento do campo 

electromagnético da mesma. 

e deve estar localizada a uma distância da estrutura de

casos esta superfície de radiação pode estar localizada a menos de ¼ do comprimento de onda, 

devendo no entanto, ser verificado

estrutura. 

As portas de excitação são outro tipo de bloco virtual que é necessário para que o HFSS 

proceda à simulação. As portas são superfícies 2D expostas a 

(condutores perfeitos ou o plano de fundo 

entram e deixam a estrutura a ser simulada.

acordo com as Equações de Maxwell para determinar apropriadamente

que vão ocorrer no interior da estrutura.

acordo com [14] são mais adequadas para simulaç

estruturas microstrip. As Lumped

calcular os parâmetros S em relação a um

utilizador e permitem excitar as estruturas no

“caixa de ar”, algo que as Wave

porta exposta ao volume a ser simulado

campos para um ou mais modos propagantes ou não propagantes, sendo portanto mais rigo

[15]. 

 

 

Condutor 
Perfeito 
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envolve toda a estrutura e que assim permite investigar o comportamento do campo 

 Esta “caixa de ar” é definida como sendo uma superfície 

a uma distância da estrutura de ¼ do comprimento de onda. Em alguns 

casos esta superfície de radiação pode estar localizada a menos de ¼ do comprimento de onda, 

verificado se ocorre grandes alterações na distribuição dos campos da 

As portas de excitação são outro tipo de bloco virtual que é necessário para que o HFSS 

proceda à simulação. As portas são superfícies 2D expostas a materiais

o plano de fundo - background) através das quais os sinais de excitação 

entram e deixam a estrutura a ser simulada. É nas portas que vão ser calculados o

acordo com as Equações de Maxwell para determinar apropriadamente os modos de excitação 

que vão ocorrer no interior da estrutura. No nosso caso vamos utilizar Lumped

são mais adequadas para simulação e análise de componentes em Silício e 

Lumped-Ports excitam a estrutura usando um único modo, permit

calcular os parâmetros S em relação a uma impedância de referência Z0 definida

tem excitar as estruturas no interior do domínio de simulação definido pela 

Wave-Ports não permitem pois só podem ter uma única superfície da 

porta exposta ao volume a ser simulado. Contudo as Wave-Ports resolvem as distribuições dos 

campos para um ou mais modos propagantes ou não propagantes, sendo portanto mais rigo

Figura 3.4: Condutor perfeito e Lumped-Ports 
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envolve toda a estrutura e que assim permite investigar o comportamento do campo 

definida como sendo uma superfície de radiação 

¼ do comprimento de onda. Em alguns 

casos esta superfície de radiação pode estar localizada a menos de ¼ do comprimento de onda, 

se ocorre grandes alterações na distribuição dos campos da 

As portas de excitação são outro tipo de bloco virtual que é necessário para que o HFSS 

materiais que não existem 

através das quais os sinais de excitação 

portas que vão ser calculados os campos de 

os modos de excitação 

Lumped-Ports que de 

e análise de componentes em Silício e 

excitam a estrutura usando um único modo, permitem 

efinida previamente pelo 

do domínio de simulação definido pela 

pois só podem ter uma única superfície da 

resolvem as distribuições dos 

campos para um ou mais modos propagantes ou não propagantes, sendo portanto mais rigorosas 

 

Lumped 

Ports 



 

Como se pode verificar, as duas portas de excitação da estrutura encontram

entre as linhas de metal que compõem 

perfeito. Esse novo bloco virtual

funciona como um caminho de retorno para os sinais de excitação

equipotencial para ambas as

simulações pois não existe um caminho de retorno para os sinais de excitação. 

alternativas de providenciar um caminho de retorno para os sinais de excitação. Uma das 

alternativas consiste na utilização do 

[31]. 

 

 

Quantos às suas dimensões, a

ser superior à largura do metal e o comprimento não deve ser demasiado longo para que não 

sejam negligenciados componentes indu

negligenciados componentes ca

igual à largura das portas. 

 

Guard-Ring 
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Como se pode verificar, as duas portas de excitação da estrutura encontram

entre as linhas de metal que compõem a bobina e um bloco virtual definido como um condutor 

perfeito. Esse novo bloco virtual “parece” curto-circuitar ambas as portas, mas na simulação 

funciona como um caminho de retorno para os sinais de excitação para além de ser um ponto 

equipotencial para ambas as portas [13]. Sem este bloco virtual, não é possível proceder às 

simulações pois não existe um caminho de retorno para os sinais de excitação. 

alternativas de providenciar um caminho de retorno para os sinais de excitação. Uma das 

as consiste na utilização do guard-ring (definido como condutor perfeito) 

Figura 3.5: Guard-Ring e Lumped-Ports 

Quantos às suas dimensões, as portas devem ser definidas com uma largura que não deve 

metal e o comprimento não deve ser demasiado longo para que não 

negligenciados componentes indutivos nem demasiado pequeno para não serem 

negligenciados componentes capacitivos [14] [15]. O comprimento deve ser aproximadamente 
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Como se pode verificar, as duas portas de excitação da estrutura encontram-se definidas 

e um bloco virtual definido como um condutor 

circuitar ambas as portas, mas na simulação 

para além de ser um ponto 

Sem este bloco virtual, não é possível proceder às 

simulações pois não existe um caminho de retorno para os sinais de excitação. Existem outras 

alternativas de providenciar um caminho de retorno para os sinais de excitação. Uma das 

(definido como condutor perfeito) para esse fim 

 

portas devem ser definidas com uma largura que não deve 

metal e o comprimento não deve ser demasiado longo para que não 

nem demasiado pequeno para não serem 

O comprimento deve ser aproximadamente 

Lumped 

Ports 
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4. Verificação experimental dos resultados gerados 

pelo simulador 

 

4.1. Objectivos 

 

Num projecto anterior, a transmissão de energia sem fios com o objectivo de alimentar 

implantes em tecidos vivos, já foi realizada [2]. Porém, foi só uma versão experimental, já que 

foram utilizados unicamente componentes discretos e a frequência utilizada foram os 13.56MHz 

(frequência típica de sistemas Radio-Frequency Indentification - RFID). O seu principal objectivo 

era provar que se podia alimentar e comunicar com dispositivos implantados recorrendo 

unicamente a um link electromagnético. 

Utilizando o simulador de campo electromagnético, tentou-se reproduzir os resultados 

práticos obtidos anteriormente, mais precisamente a transmissão de energia entre a bobina 

emissora e a receptora.  

Esta fase do trabalho tinha como principal objectivo comprovar a fiabilidade do simulador 

através dos resultados experimentais obtidos em [2], e simultaneamente ser um meio de 

adaptação ao ambiente de trabalho do simulador de campo electromagnético, tomar 

conhecimento de grande parte das potencialidades do simulador e ainda perceber quase todos os 

mecanismos necessários para realizar as simulações. 

Para proceder a uma análise no domínio do tempo, outro programa foi utilizado. O 

programa em causa é o Ansoft Designer [32] que para além de permitir a importação da matriz 

dos parâmetros S obtida pelo simulador de campo electromagnético (através do bloco funcional 

N-port Data), possibilita interligar esse mesmo bloco com diversos componentes (descrito no 

capítulo 8 de [31]). 

 

4.2. Bobina Emissora 

 

A bobina emissora é realizada com as espiras quadradas sendo construída em PCB. O 

diâmetro exterior é de 75mm e é composto por 2 voltas. A largura das espiras é de 4mm e o 

espaçamento entre espiras é de 3mm. As espiras são de cobre com uma espessura de 35µm. Em 

[2] o valor da indutância desta bobina é de 500 nH. 

 



 

O seu desenho no simulador de campo electromagnético encontra

 

 

Como termo de comparação, apresenta

realizada em [2] (ver figuras 4.2 e 4.3)
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simulador de campo electromagnético encontra-se a seguir.

Figura 4.1: Bobina Emissora (500nH) 

mo de comparação, apresenta-se uma fotografia e o Layout

4.2 e 4.3). 

Figura 4.2: Fotografia da Bobina Emissora 
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se a seguir. 

 

Layout da mesma bobina 

 



 

 

 

Procedendo à simulação com o objectivo de calcular o valo

emissora, definindo previamente o tipo de solução e a frequência da solução, os resultados 

obtidos para o valor da indutância e do factor de qualidade encontram

figura 4.4 e 4.5). 

 

Figura 4.4: Gráfico da Indutância vs Frequência para 
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Figura 4.3: Layout do Bobina Emissora (500nH) 

Procedendo à simulação com o objectivo de calcular o valor da indutância da bobina

, definindo previamente o tipo de solução e a frequência da solução, os resultados 

da indutância e do factor de qualidade encontram-se seguidamente

: Gráfico da Indutância vs Frequência para a bobina emissor
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r da indutância da bobina 

, definindo previamente o tipo de solução e a frequência da solução, os resultados 

se seguidamente (ver 

 

a 



 

Figura 4.5: Gráfico do factor de qu

 

 

4.3. Bobina Receptor

 

A bobina receptora é realizada

diâmetro exterior é de 20mm e é composto

espaçamento entre espiras é de 0.25 mm.

O valor da indutância desta bobina

 

 

 

 

 

 

 

 

 

Nélson Miguel da Silva Ricardo
Indutores Integrados para Sistemas de Recolha de Energia sem 

: Gráfico do factor de qualidade (Q) vs Frequência para a bobina

Receptora 

A bobina receptora é realizada com as espiras quadradas sendo construída

exterior é de 20mm e é composto por 7 voltas. A largura das espiras é de 0.25

espaçamento entre espiras é de 0.25 mm. As espiras são de cobre com uma espessura de 35

bobina apresentado por [2 ] é de 1580nH. 
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bobina emissora 

piras quadradas sendo construída em PCB. O 

A largura das espiras é de 0.25mm e o 

e com uma espessura de 35µm. 



 

O seu desenho no simulador de campo electromagnético encontra

 

 

 

Uma fotografia das bobinas 

onde se destaca a bobina receptora de 1580nH.

 

Figura 4.7: Fotografia das Bobinas Receptoras utilizadas em [2]
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O seu desenho no simulador de campo electromagnético encontra-se a seguir.

Figura 4.6: Bobina Receptora (1580nH) 

Uma fotografia das bobinas receptoras realizadas em [2] apresenta

onde se destaca a bobina receptora de 1580nH. 

Figura 4.7: Fotografia das Bobinas Receptoras utilizadas em [2] 
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se a seguir. 

 

receptoras realizadas em [2] apresenta-se seguidamente, 

 

 



 

O Layout desta bobina realizado anteriormente em [2] apresenta

 

 

 

Os resultados obtidos para a indutância e factor de qualidade apresentam

(ver figuras 4.9 e 4.10). 

 

Figura 4.9
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desta bobina realizado anteriormente em [2] apresenta-se a seguir.

 

Figura 4.8: Layout da bobina receptora (1580nH) 

Os resultados obtidos para a indutância e factor de qualidade apresentam

9: Gráfico da Indutância vs Frequência para a bobina receptor
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se a seguir. 

Os resultados obtidos para a indutância e factor de qualidade apresentam-se de seguida 

 

receptora 



 

Figura 4.10: Gráfico do factor de qualidade (Q) vs Frequência para 

 

Podemos portanto afirmar que os resultados obtidos para os valores da indutância estão 

em linha com os obtidos em [2] (com um erro máximo de 

 

4.4. Simulação da Transferência de 

 

Para proceder à simulação da transferência de 

colocadas com as partes superiores viradas uma para a outra e com os seus centros 

perfeitamente alinhados. A distância a que se encontram 

comprovar a dependência da tensão induzida com a distância entre 

De forma a simular a transferência

excitação (lumped ports) foram usadas, sendo aplicadas 2 a cada 
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: Gráfico do factor de qualidade (Q) vs Frequência para a bobina

Podemos portanto afirmar que os resultados obtidos para os valores da indutância estão 

em linha com os obtidos em [2] (com um erro máximo de 8%). 

ção da Transferência de Energia sem fios 

Para proceder à simulação da transferência de energia sem fios, as duas bobinas

s com as partes superiores viradas uma para a outra e com os seus centros 

perfeitamente alinhados. A distância a que se encontram as duas bobinas foi variada de forma a 

comprovar a dependência da tensão induzida com a distância entre as bobinas

simular a transferência de energia entre as duas bobinas

foram usadas, sendo aplicadas 2 a cada bobina (ver figura

lson Miguel da Silva Ricardo 
s para Sistemas de Recolha de Energia sem Fios 

49 

 

bobina receptora 

Podemos portanto afirmar que os resultados obtidos para os valores da indutância estão 

as duas bobinas foram 

s com as partes superiores viradas uma para a outra e com os seus centros 

foi variada de forma a 

as bobinas. 

as duas bobinas, 4 portas de 

r figuras 4.11 e 4.12). 



 

Figura 4.

 

Figura 4.12

 

As matrizes dos parâmetros S obtidos nas simulações, fora

poderem ser utilizadas no so

tempo, como explicado no inicio deste capítulo

O circuito (ver figura 4.13

sintonizados para os 13.56MHz

capacidades foram optimizadas de forma a maximizar a tensão induzida no receptor.

os pinos 1, 2, 3 e 4 é o modelo eléctrico do nosso sistema sobre teste. 

terminais 1 e 2 são ambos os terminais da

respeito aos terminais da bobina
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Figura 4.11: Simulação da Transferência de Energia (3 cm) 

Figura 4.12: Simulação da Transferência de Energia (8 cm) 

As matrizes dos parâmetros S obtidos nas simulações, foram exportadas de forma a 

no software Ansoft Designer, para realizar simulações no domínio do 

, como explicado no inicio deste capítulo. 

(ver figura 4.13) utilizado na simulação é constituído por

sintonizados para os 13.56MHz. Foi utilizada no receptor uma carga de 10KΩ, tal como 

capacidades foram optimizadas de forma a maximizar a tensão induzida no receptor.

é o modelo eléctrico do nosso sistema sobre teste. Pode

1 e 2 são ambos os terminais da bobina emissora, enquanto os terminais 3 e 4

bobina receptora. 
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exportadas de forma a 

para realizar simulações no domínio do 

é constituído por 2 circuitos LC 

Ω, tal como em [2]. As 

capacidades foram optimizadas de forma a maximizar a tensão induzida no receptor. A DUT com 

Pode-se pensar que os 

enquanto os terminais 3 e 4 dizem 
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Figura 4.13: Circuito utilizado para proceder à análise no domínio do tempo 

  

Para uma distância entre as bobinas de 3 cm, obteve-se a seguinte tensão induzida: 

 

Figura 4.14: Tensão induzida a uma distância de 3 cm 
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Para uma distância entre as bobinas de 8 cm, obteve-se a seguinte tensão induzida: 

 

Figura 4.15: Tensão induzida a uma distância de 8 cm 

 

4.5. Comparação entre os Resultados Experimentais e Simulados 

 

Como já referido, ambos os valores obtidos através de simulação (para a indutância da 

bobina emissora e da bobina receptora), encontram-se dentro do indicado em [2] 

Quanto aos factores de qualidade de ambos as bobinas, só podemos comparar o valor 

obtido para a bobina receptora. Através de simulação, a uma frequência de 13.56MHz, o factor de 

qualidade da bobina receptora é de 105, alcançando o valor máximo de 110 a 23MHz. Na prática, 

o valor do factor de qualidade foi de 146 a 13.56MHz.  

Quanto à tensão induzida no receptor, na prática o valor máximo induzido foi de 5Vp, mas 

não é especificada a distância entre as duas bobinas. Nas simulações realizadas a uma distância 

de 3 cm, é induzida uma tensão de 8.5Vp (14.4mW). Com o aumento da distância, verifica-se uma 

diminuição da tensão induzida, tal como seria de esperar. Para uma distância de 8 cm, a tensão 

induzida é de apenas 1.3Vp (338µW), o que mais uma vez não está longe do medido. De notar que 

existirá sempre um ligeiro erro associado a potenciais diferenças que podem existir entre as 

definições utilizadas no simulador para os diferentes materiais (condutividade, permitividade, 

espessura), e o valor real desses mesmos materiais.  

Em termos gerais podemos concluir que o desempenho do simulador mostrou ser muito 

satisfatório, apresentando resultados parecidos aos experimentais. 



Nélson Miguel da Silva Ricardo 
Indutores Integrados para Sistemas de Recolha de Energia sem Fios 

53 

 

5. Estudo sistemático de Bobinas Planares 

 

5.1. Tecnologia utilizada 

 

Antes de proceder ao estudo sistemático de bobinas planares utilizando o simulador de 

campo electromagnético, é necessário definir previamente no mesmo simulador, os parâmetros 

tecnológicos do processo CMOS utilizado. 

O processo utilizado foi o AMS 0.35µm CMOS C35. Neste processo existem 4 camadas de 

metal (alumínio), sendo a última camada a mais espessa (Metal 4). Na figura seguinte está 

representado um corte transversal da tecnologia utilizada, onde se destacam as espessuras das 

diferentes camadas. 

 

 

Figura 5.1: Secção transversal da tecnologia utilizada 

 

Antes de se proceder ao estudo sistemático de bobinas planares utilizando o simulador de 

campo electromagnético, é necessário definir previamente no mesmo simulador as características 

dos materiais utilizados, nomeadamente a condutividade e permitividade do substrato, 

permitividade das restantes camadas (IMD, PROT, ILDFOX) e a condutividade e espessura das 



 

diferentes camadas de metal. 

compõem sejam iguais, são definidas como sendo uma única camada. Neste caso, isso acontece 

com as 3 camadas IMD, podendo verificar

topo). 

 

Figura 5.2: Parâmetros tecnológicos 

 

Na gama de frequências utilizada e tendo em conta a espessura do metal utilizado, é 

necessário entrar em conta com o efeito pelicular. Por isso mesmo, é

simulador para resolver os campos também no interior

defeito, a partir de um valor predefinido de condutividade, o simulador não acciona essa opção 

nas estruturas criadas. 

De forma a visualizar os resultados obtidos directamente no simulador (Indutância 

Factor de Qualidade Q, duas variáveis foram definidas no simulador (

 

 

 

Especificando a frequência 

para se proceder ao estudo de 

electromagnético estão definidos
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diferentes camadas de metal. No simulador, camadas cujas propriedades do material que as 

compõem sejam iguais, são definidas como sendo uma única camada. Neste caso, isso acontece 

com as 3 camadas IMD, podendo verificar-se essa fusão na figura 5.2 (3ª camada a contar do 

Figura 5.2: Parâmetros tecnológicos definidos no simulador  

Na gama de frequências utilizada e tendo em conta a espessura do metal utilizado, é 

necessário entrar em conta com o efeito pelicular. Por isso mesmo, é fundamental

simulador para resolver os campos também no interior dos condutores (solve inside on

a partir de um valor predefinido de condutividade, o simulador não acciona essa opção 

De forma a visualizar os resultados obtidos directamente no simulador (Indutância 

variáveis foram definidas no simulador (Add Output Variables

� = 79 c 1d��e
2 ∗  3 ∗ P54f<g"$78 

2 = − 79�d��	54�d��	 

Especificando a frequência da solução para 405 MHz, todos os mecanismos necessários 

para se proceder ao estudo de bobinas planares usando um simulador de campo 

electromagnético estão definidos (ver figura 5.3). 
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riedades do material que as 

compõem sejam iguais, são definidas como sendo uma única camada. Neste caso, isso acontece 

se essa fusão na figura 5.2 (3ª camada a contar do 

 

Na gama de frequências utilizada e tendo em conta a espessura do metal utilizado, é 

fundamental indicar ao 

solve inside on), pois por 

a partir de um valor predefinido de condutividade, o simulador não acciona essa opção 

De forma a visualizar os resultados obtidos directamente no simulador (Indutância L, 

Add Output Variables): 

todos os mecanismos necessários 

planares usando um simulador de campo 



 

Figura 5.3: Estrutura completa para a realização das simulações

 

A metodologia utilizada para o estudo d

realizado em [23]. A técnica utilizada mostra quantitativamente a influência dos parâmet

desenho na performance das 

 Todas as bobinas foram desenhadas

pois como se trata da camada de metal mais e

é a camada mais afastada do substrato, apresenta uma

as bobinas consideradas são quadradas

A metodologia utilizada consi

diâmetro interior da bobina. De seguida é efectuado o estudo sobre a 

entre pistas e por último são analisados os efeitos causados pela variação da largura das 

metal. 
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Figura 5.3: Estrutura completa para a realização das simulações 

A metodologia utilizada para o estudo das bobinas planares foi baseada no trabalho 

o em [23]. A técnica utilizada mostra quantitativamente a influência dos parâmet

s bobinas planares integradas em substratos condutivos. 

Todas as bobinas foram desenhadas utilizando a última camada de metal da tecnologia

omo se trata da camada de metal mais espessa, a sua resistividade é menor. 

mais afastada do substrato, apresenta uma capacidade para o substrato menor.

são quadradas.  

A metodologia utilizada consiste primeiro no estudo dos efeitos causado

. De seguida é efectuado o estudo sobre a influência

são analisados os efeitos causados pela variação da largura das 
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planares foi baseada no trabalho 

o em [23]. A técnica utilizada mostra quantitativamente a influência dos parâmetros de 

s em substratos condutivos.  

utilizando a última camada de metal da tecnologia, 

menor. Como também 

capacidade para o substrato menor. Todas 

causados pela variação do 

influência do espaçamento 

são analisados os efeitos causados pela variação da largura das pistas de 
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5.2. Efeitos causados pela variação do diâmetro interior 

 

O diâmetro interior da bobina (Din), acaba por ser um dos parâmetros mais importantes 

não só no que respeita à performance do mesmo, mas também acaba por determinar em grande 

medida a área que vai ser ocupada pela bobina. 

Para perceber a importância de Din na performance da bobina, procedeu-se à simulação 

de 7 bobinas. É importante que as bobinas apresentem valores semelhantes de indutância para se 

perceber efectivamente a influência do diâmetro interior. As bobinas foram construídas variando 

unicamente o diâmetro interior (e consequentemente o exterior) e o número de voltas, de forma 

a manterem valores semelhantes de indutância. A largura e o espaçamento das espiras foram 

mantidos constantes. As principais características das bobinas simuladas encontram-se na tabela 

seguinte (onde para comparação se incluem os valores de indutância usando as fórmulas 

aproximadas do capitulo 2): 

 

Din (µm) 44 114 156 208 270 362 484 

Dout (µm) 424 430 440 460 490 550 640 

Voltas 12 10 9 8 7 6 5 

Largura (µm) 14 14 14 14 14 14 14 

Espaçamento (µm) 2 2 2 2 2 2 2 

Modified Wheeler (nH) 30.65 30.79 30.72 30.85 30.48 30.81 29.90 

Current Sheet (nH) 31.39 30.80 30.51 30.51 30.16 30.77 30.60 

Monomial Fit (nH) 28.84 29.40 29.52 29.82 29.69 30.39 30.20 

Tabela 1.1: Características das bobinas simuladas para estudar o efeito de Din 

 

O facto de as bobinas serem desenhadas com diferente número de voltas leva a que 

existam diferentes quantidades de acoplamento indutivo e capacitivo. Contudo, se as bobinas 

fossem desenhadas com o mesmo número de voltas, variando unicamente o raio interior, iria 

haver grandes diferenças quanto aos valores obtidos para a indutância das diferentes bobinas, 

impossibilitando qualquer tipo de comparação do factor de qualidade. 
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Os gráficos da indutância e factor de qualidade apresentam-se seguidamente: 

 

Figura 5.4: Indutância das 7 bobinas simuladas - variação de Din 

 

Figura 5.5: Factor de qualidade (Q) das 7 bobinas simuladas - variação de Din 
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Os resultados obtidos demonstram que com o aumento do diâmetro interior, verifica-se 

uma melhoria do factor de qualidade. A bobina com um diâmetro interior de 362µm apresenta o 

melhor factor de qualidade. É importante referir que a comparação entre os diversos factores de 

qualidade deve ser efectuada numa zona em que todas as bobinas apresentem valores 

semelhantes de indutância, daí a importância do gráfico da indutância apresentado. 

Verifica-se uma melhoria do factor de qualidade com o aumento de Din. Contudo, a partir 

de certo valor de Din, deixa de compensar aumentar o diâmetro interior pois o factor de qualidade 

pouco melhora, aumentando a área e consequentemente o custo. No caso da simulação realizada 

para Din = 484, até se verifica uma redução de Q. 

Às frequências mais baixas, todas as bobinas apresentam valores semelhantes de 

indutância, que também são semelhantes aos apresentados na tabela 1.1. Também os factores de 

qualidade têm quase todos o seu máximo relativamente perto uns dos outros, tal como as 

frequências de ressonância, o que indica que apresentam quase todos o mesmo nível de perdas 

no substrato. 

A melhoria que se verifica com o aumento de Din, pode ser justificada com o facto de que 

para bobinas com um Din muito pequeno, as linhas de campo magnético criadas pelas espiras 

mais afastadas do centro, acabam por penetrar nas espiras mais próximas do centro, levando ao 

surgimento de um campo eléctrico magneticamente induzido, que leva ao aparecimento de 

correntes parasitas no condutor. Essas correntes criam uma distribuição não uniforme da 

corrente, que, juntamente com o efeito pelicular e de proximidade, aumentam a resistência do 

condutor, aumentando o número de perdas nas espiras interiores e reduzindo assim o factor de 

qualidade [8] [23]. 

 

5.3. Efeitos causados pela variação do espaçamento entre espiras 

 

Para perceber os efeitos criados pelo espaçamento entre espiras adjacentes, 7 novas 

bobinas foram simuladas. Procedeu-se unicamente à variação do espaçamento (S) entre as 

espiras. Os valores da largura (W) e diâmetro interior (Din) foram mantidos constantes. Pela 

imposição de um Din constante, devido à variação do espaçamento, o diâmetro exterior (Dout) 

acaba por aumentar. Felizmente, esse aumento acaba por ser pouco significativo em comparação 

com as variações encontradas para Dout aquando da variação de Din. Mais uma vez, a indutância às 

baixas frequências mantém-se constate (aproximadamente igual a 30nH) 
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As características das bobinas simuladas encontram-se na tabela seguinte: 

 

Din (µm) 362 362 362 362 362 362 362 

Dout (µm) 540 545 550 555 560 565 570 

Voltas 6 6 6 6 6 6 6 

Largura (µm) 14 14 14 14 14 14 14 

Espaçamento (µm) 1.0 1.5 2.0 2.5 3.0 3.5 4 

Modified Wheeler (nH) 30.95 30.88 30.81 30.74 30.68 30.62 30.57 

Current Sheet (nH) 30.98 30.87 30.77 30.68 30.60 30.52 30.44 

Monomial Fit (nH) 30.90 30.59 30.39 30.26 30.16 30.09 30.03 

Tabela 1.2: Características das bobinas simuladas para estudar o efeito do espaçamento (S) 

 

Os gráficos da indutância e factor de qualidade obtidos, apresentam-se seguidamente (ver figuras 

5.6 e 5.7): 

 

Figura 5.6: Indutância das 7 bobinas simuladas - variação do espaçamento (S) 
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Figura 5.7: Factor de qualidade (Q) das 7 bobinas simuladas - variação do espaçamento (S) 

 

Às baixas frequências todas as bobinas apresentam valores semelhantes de indutância, 

que também são semelhantes aos apresentados na tabela 1.2. 

A 405 MHz (frequência a que é gerada a malha de elementos), as bobinas apresentam 

factores de qualidade idênticos, verificando-se um ligeiro aumento do factor de qualidade com o 

aumento do espaçamento, sendo que o maior factor de qualidade acontece para S=3.5µm. 

Os valores máximos dos factores de qualidade encontram-se numa gama de frequências 

bastante abrangente, verificando-se um deslocamento para a direita do factor de qualidade com 

o aumento do espaçamento (S). A melhoria verificada no valor máximo do factor de qualidade 

pode ser justificada com uma redução da resistência devido à diminuição do efeito de 

proximidade. Quanto ao facto de os valores máximos do factor de qualidade estarem numa gama 

de frequências bastante alargada, prende-se mais com o facto de a capacidade entre espiras 

adjacentes do que com o diferente nível de perdas no substrato, pois apesar de apresentarem 

áreas diferentes, a diferença entre áreas é bastante pequena o que não justificaria estes 

resultados.  
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5.4. Efeitos causados pela variação da largura da espira 

 

Para estudar os efeitos causados pela variação da largura da pista (W), 7 novas bobinas 

foram simuladas. O diâmetro interior (Din), o espaçamento e o número de voltas foram mantidos 

constantes, variando unicamente a largura da pista (W). As principais características das bobinas 

simuladas estão presentes na tabela seguinte: 

 

Din (µm) 362 362 362 362 362 362 362 

Dout (µm) 469 517 565 613 661 709 757 

Voltas 6 6 6 6 6 6 6 

Largura (µm) 6 10 14 18 22 26 30 

Espaçamento (µm) 3.5 3.5 3.5 3.5 3.5 3.5 3.5 

Modified Wheeler (nH) 32.48 31.33 30.62 30.21 30.02 29.98 26.26 

Current Sheet (nH) 33.45 31.55 30.52 29.96 29.70 29.64 25.98 

Monomial Fit (nH) 32.84 30.98 30.09 29.65 29.49 29.51 25.89 

Tabela 1.3: Características das bobinas simuladas para estudar o efeito da largura (W) 

 

Os resultados das simulações encontram-se seguidamente (ver figuras 5.8 e 5.9): 

 

Figura 5.8: Indutância das 7 bobinas simuladas - variação da largura (W) 
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Figura 5.9: Factor de qualidade (Q) das 7 bobinas simuladas - variação da largura (W) 

 

As bobinas simuladas apresentam valores semelhantes de indutância às baixas 

frequências. No entanto, já se conseguem distinguir mais facilmente as várias curvas para as 

diferentes bobinas (algo que não acontecia nos gráficos de indutância anteriores). Isto já seria de 

esperar porque todas as bobinas acabam por ter comprimentos totais diferentes, logo áreas 

diferentes, devido a manterem o mesmo número de voltas mas diferente largura das pistas. 

Tal como verificado experimentalmente em [23], o valor da indutância por unidade de 

comprimento aumenta com a diminuição da largura das espiras. Essa relação pode ser verificada 

na tabela seguinte. Recorrendo a esta tabela, bobinas com diferente largura de pista, podem ser 

construídos de forma a terem o mesmo valor de indutância. 

 

Largura (µm) 6 10 14 18 22 26 30 

Comprimento Total (mm) 9.982 10.562 11.142 11.722 12.302 12.882 13.462 

Indutância @ 200MHz (nH) 28.06 27.74 27.50 27.31 27.29 28.09 28.84 

Indutância/Comp (pH/µm) 2.81 2.63 2.47 2.33 2.22 2.18 2.14 

Tabela 1.4: Indutância por unidade de comprimento, para as 7 bobinas simuladas 
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O factor de qualidade máximo é para a bobina com W=26μm. Com o aumento da largura 

da pista, verifica-se não só um aumento do valor do factor de qualidade como também um 

deslocamento desse máximo para uma frequência mais baixa. Este deslocamento é consequência 

de um aumento da área da bobina e consequente aumento da capacidade para o substrato. O 

aumento do factor de qualidade prende-se com o facto de a resistência do condutor diminuir com 

o aumento da largura da pista. 

No caso da bobina com W=30μm, verifica-se uma ligeira diminuição do factor de 

qualidade, pois o aumento da largura da pista (e consequente diminuição da resistência), não 

consegue compensar o facto de as linhas de campo magnético criado pelas espiras exteriores 

penetrarem nas espiras interiores e, pelo mecanismo já explicado anteriormente, aumentarem a 

resistência do condutor. Como todas as bobinas simuladas apresentam o mesmo diâmetro 

interior (Din), o diâmetro exterior desta bobina (W=30μm) é o maior de todos as simuladas e é de 

esperar que aumentando ainda mais a largura da pista, não se verifiquem melhorias no factor de 

qualidade devido ao aumento da resistividade. 

Estes resultados levam à conclusão que a largura da pista é um parâmetro que influencia 

a resistência do condutor (logo o seu factor de qualidade), a indutância por unidade de 

comprimento e a frequência a que ocorre o máximo factor de qualidade, sendo portanto, um 

importante parâmetro no desenho e optimização de bobinas planares. 
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6.  Desenho de Bobinas Planares para 433 MHz e 900MHz 

 

6.1. Bobina optimizada para 433MHz 

 

6.1.1. Metodologia 

 

Para projectar uma bobina optimizada para os 433MHz, foi utilizada uma metodologia 

semelhante à encontrada no capítulo anterior, onde se efectuou um estudo sistemático de 

bobinas planares. 

Numa dada gama de frequências, as bobinas integradas com um elevado valor de 

indutância tendem a ter valores de factor de qualidade mais baixos em comparação com bobinas 

de menor valor de indutância. Contudo, a capacidade de receber potência, pode ser aumentada, 

aumentando o valor da indutância, mas este aumento do valor da indutância só é conseguido 

através de um aumento da área da bobina e consequentemente do custo [1]. Tendo um conta 

todos estes factores, optou-se por simular e optimizar uma bobina de aproximadamente 30nH. 

Inicialmente foi definido no simulador a frequência de simulação para os 433 MHz. 

Seguidamente, efectuou-se um estudo de qual o melhor diâmetro interior (Din), espaçamento (S) 

e largura da pista (W). Por último, é aplicada uma técnica com vista a melhorar o factor de 

qualidade. Esta técnica consiste na utilização de camadas adjacentes de metal para construir a 

bobina. 

 

6.1.2. Diâmetro interior (Din) 

 

Tendo em atenção os resultados obtidos no capítulo 5, optou-se por começar o desenho 

desta bobina utilizando um espaçamento S=2µm e uma largura da pista W=26µm. Como se sabe à 

partida que iremos necessitar de uma elevada largura da pista para sintonizar o máximo do factor 

de qualidade para a frequência de 433 MHz e diminuir a resistência, optou-se por utilizar um 

elevado valor de W já no estudo de Din. 

À semelhança do que foi realizado anteriormente, o único parâmetro que variou foi o 

diâmetro interior e o número de voltas da bobina, de forma a manter constante o valor da 

indutância. 
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Foram simuladas 5 bobinas cujas características encontram-se na tabela seguinte. 

 

Din (µm) 120 194 282 389 528 

Dout (µm) 620 638 670 721 804 

Voltas 9 8 7 6 5 

Largura (µm) 26 26 26 26 26 

Espaçamento (µm) 2 2 2 2 2 

Modified Wheeler (nH) 30.83 31.73 32.34 32.24 31.19 

Current Sheet (nH) 31.10 31.63 32.01 31.89 31.15 

Monomial Fit (nH) 29.92 31.04 31.88 32.05 31.45 

Tabela 2.1: Características das bobinas simuladas para escolher Din (433 MHz) 

 

Os resultados obtidos para a indutância e factor de qualidade foram os seguintes (ver figuras 6.1 e 

6.2): 

 

Figura 6.1: Indutância das 5 bobinas simuladas – variação de Din 
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Figura 6.2: Factor de qualidade das 5 bobinas simuladas – variação de Din 

 

À frequência a que se realiza a simulação, as bobinas apresentam valores semelhantes de 

indutância. É importante referir que os máximos do factor de qualidade de todas as bobinas se 

encontram numa gama muito próxima, tal como as suas frequências de ressonância, o que 

significa que todos apresentam perdas no substrato semelhantes, devido ao facto de terem áreas 

aproximadamente iguais. A 433 MHz, a bobina que apresenta melhor factor de qualidade, é a que 

ocupa maior área. Apesar disso, a bobina com Din=389µm, apresenta um factor muito parecido 

com uma área substancialmente menor, daí que este valor de Din=389µm tenha sido escolhido. 

 

6.1.3. Espaçamento entre pistas (S) 

 

De forma a verificar qual o melhor espaçamento entre pistas, 3 bobinas foram simuladas. 

O único parâmetro que variou foi o espaçamento, sendo que o diâmetro interior foi Din=389µm e 

a largura da pista W=26µm. 
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As características dessas bobinas encontram-se na tabela seguinte: 

 

Din (µm) 389 389 389 

Dout (µm) 711 721 731 

Voltas 6 6 6 

Largura (µm) 26 26 26 

Espaçamento (µm) 1 2 3 

Modified Wheeler (nH) 32.26 32.24 32.22 

Current Sheet (nH) 31.91 31.89 31.87 

Monomial Fit (nH) 32.56 32.05 31.81 

Tabela 2.2: Características das bobinas simuladas para escolher S (433 MHz) 

 

Os resultados obtidos para a indutância e factor de qualidade foram os seguintes (ver figura 6.3 e 

6.4): 

 

Figura 6.3: Indutância das 3 bobinas simuladas – variação de S 
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Figura 6.4: Factor de qualidade para as 3 bobinas simuladas – variação de S 

 

Mais uma vez, as bobinas apresentam valores de indutância bastante idênticos à 

frequência a que se realiza a simulação, sendo portanto, um bom ponto para se compararem os 

diferentes factores de qualidade. A essa frequência, as bobinas com S=2µm e S=3µm, apresentam 

factores de qualidade semelhantes, mas a bobina com S=1µm, apresenta o pior factor de 

qualidade. Isso deve-se ao facto de haver um aumento significativo da resistência devido ao efeito 

de proximidade. O deslocamento verificado para a direita com o aumento do espaçamento entre 

pistas, deve-se à diminuição da capacidade entre espiras adjacentes.  

  O valor escolhido para o espaçamento, foi S=2µm, pois apesar de se verificar um aumento 

do factor de qualidade para S=3µm, esse pequeno aumento, não compensa o aumento de área 

para além de levar a uma pequena deslocação do máximo para uma frequência superior. 
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6.1.4. Largura da pista (W) 

 

Anteriormente foram obtidos os valores de Din=389µm e S=2µm. Utilizando estes valores 

e fixando também o número de voltas, procedeu-se à simulação de 4 novas bobinas de forma a 

escolher a largura da pista que vai ser utilizada. As características dessas bobinas encontram-se na 

tabela seguinte. 

 

Din (µm) 389 389 389 389 

Dout (µm) 673 721 769 817 

Voltas 6 6 6 6 

Largura (µm) 22 26 30 34 

Espaçamento (µm) 2 2 2 2 

Modified Wheeler (nH) 32.39 32.24 32.22 32.30 

Current Sheet (nH) 32.09 31.89 31.85 31.94 

Monomial Fit (nH) 32.11 32.05 32.13 32.32 

Tabela 2.3: Características das bobinas simuladas para escolher W (433 MHz) 

 

Os resultados obtidos para a indutância e factor de qualidade foram os seguintes: 

 

Figura 6.5: Indutância das 4 bobinas simuladas – variação de W 
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Figura 6.6: Factor de qualidade para as 4 bobinas simuladas – variação de W 

 

Os resultados demonstram uma pequena variação em todos os valores máximos do factor 

de qualidade, sendo que o valor máximo ocorre para a bobina com W=26µm. Tal como já tinha 

ocorrido anteriormente, a largura da pista é uma parâmetro que permite, dentre de certos 

limites, alinhar o máximo do factor de qualidade com a frequência de operação. Tendo isto em 

conta e o facto de a 433MHz a bobina com W=30µm apresenta o melhor factor de qualidade, 

apesar de ocupar uma área maior, foi esta a largura da pista escolhida. 

 

6.1.5. Bobina multi-camada 

 

Várias técnicas são utilizadas para optimizar a bobina, nomeadamente o seu factor de 

qualidade. Muitas dessas técnicas aumentam o custo do chip devido a recorrerem a alterações na 

tecnologia utilizada. Outras técnicas felizmente não aumentam o custo do chip mas dificultam o 

desenho da bobina. A utilização de 2 camadas adjacentes de metal para construir a bobina 

utilizando a terceira camada para providenciar a ligação ao exterior, é uma destas técnicas. 



 

Seguidamente, apresenta

interligadas por um elevado número de vias. A

escolhidos nos passos anteriores (W=30µm, S=2µm, D

Figura 6.7: Indutância para a

 

Figura 6.8: Factor de qualida
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Seguidamente, apresenta-se os resultados da simulação de uma bobina

por um elevado número de vias. A bobina simulada tem os parâmetros que foram 

s nos passos anteriores (W=30µm, S=2µm, Din=389µm). 

Figura 6.7: Indutância para a bobina com 2 camadas de metal (433MHz)

Figura 6.8: Factor de qualidade para a bobina com 2 camadas de metal (433MHz)
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bobina com 2 camadas, 

os parâmetros que foram 

 

(433MHz) 

 

camadas de metal (433MHz) 



 

Os resultados obtidos são claros. Com a utilização de 2 camadas de metal adja

factor de qualidade da bobina

consequentemente das perdas. Verifica

433MHz, o valor da indutância é aproximadamente constante send

da bobina bastante afastada da gama 

Simulou-se a mesma 

bobina e a camada mais próxima do substrato 

Verifica-se uma ligeira deslocação do máximo do factor de qualidade para uma frequência mais 

baixa, devido ao aumento da capacidade para o 

atenuadas. A utilização das 3 camadas de metal interligadas por vias, resulta 

resistividade da bobina, aumentando o valor máximo do factor de qualidade. Os resultados 

obtidos podem ser consultados nas figuras 

(a 433MHz) de 70% em relação à bobina original (só com uma cam

 

Figura 6.9: Indutância para a
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Os resultados obtidos são claros. Com a utilização de 2 camadas de metal adja

bobina acaba por melhorar devido a uma diminuição da resistência e 

consequentemente das perdas. Verifica-se também que na gama de frequências perto dos 

433MHz, o valor da indutância é aproximadamente constante sendo a frequência de ressonância 

afastada da gama de frequências usáveis para esta bobina

 bobina, mas agora utilizando 3 camadas adjacentes de metal para a

e a camada mais próxima do substrato para a ligação desde a volta interior até ao exterior. 

deslocação do máximo do factor de qualidade para uma frequência mais 

baixa, devido ao aumento da capacidade para o substrato. No entanto as perdas resistivas são 

atenuadas. A utilização das 3 camadas de metal interligadas por vias, resulta 

, aumentando o valor máximo do factor de qualidade. Os resultados 

obtidos podem ser consultados nas figuras 6.9 e 6.10. Neles pode-se constatar um aumento do Q 

em relação à bobina original (só com uma camada de metal).

: Indutância para a bobina com 3 camadas de metal (433MHz)
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Os resultados obtidos são claros. Com a utilização de 2 camadas de metal adjacentes, o 

acaba por melhorar devido a uma diminuição da resistência e 

se também que na gama de frequências perto dos 

o a frequência de ressonância 

bobina. 

madas adjacentes de metal para a 

a ligação desde a volta interior até ao exterior. 

deslocação do máximo do factor de qualidade para uma frequência mais 

as perdas resistivas são 

atenuadas. A utilização das 3 camadas de metal interligadas por vias, resulta numa redução da 

, aumentando o valor máximo do factor de qualidade. Os resultados 

se constatar um aumento do Q 

ada de metal). 

 

MHz) 



 

Figura 6.10: Factor de qual

 

6.2. Bobina optimizada

 

6.2.1. Metodologia

 

Tal como no ponto a 6.1, a metodologia 

900MHz, baseia-se não só no método mas também nos resultados obtidos no capítulo 5.

Tal como já foi referido anteriormente, 

integradas com um elevado valor de indutância,

em comparação com bobinas 

aumentamos a capacidade de receber potência, mas este a

conseguido através de um aumento da área da bobina. Tendo um conta todos estes factores, 

optou-se por simular e optimizar

Primeiramente, começou

electromagnético para 900MHz. A partir dai, vária

primeiramente por escolher o diâmetro interior (D

escolher o espaçamento e por último, realizaram

pistas. Com o objectivo de melhorar ainda

novamente bobinas composta
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Figura 6.10: Factor de qualidade para a bobina com 3 camadas de metal (433MHz)

Bobina optimizada para 900MHz 

Metodologia 

Tal como no ponto a 6.1, a metodologia utilizada para optimizar um

se não só no método mas também nos resultados obtidos no capítulo 5.

Tal como já foi referido anteriormente, numa dada gama de frequências, 

integradas com um elevado valor de indutância, acabam por ter factores de qualidade

bobinas de baixo valor de indutância. Aumentando o valor da indutância, 

a capacidade de receber potência, mas este aumento do valor da indutância

conseguido através de um aumento da área da bobina. Tendo um conta todos estes factores, 

se por simular e optimizar novamente uma bobina de aproximadamente 30nH.

Primeiramente, começou-se por definir a frequência da solução no simulador 

para 900MHz. A partir dai, várias bobinas foram simulada

primeiramente por escolher o diâmetro interior (Din), seguidamente foi feito um estudo para 

escolher o espaçamento e por último, realizaram-se mais simulações para escolher a largu

Com o objectivo de melhorar ainda mais o factor de qualidade, foram

bobinas compostas pela interligação de várias camadas de metal. 
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3 camadas de metal (433MHz) 

utilizada para optimizar uma bobina para os 

se não só no método mas também nos resultados obtidos no capítulo 5. 

numa dada gama de frequências, as bobinas 

de qualidade mais baixos 

Aumentando o valor da indutância, 

umento do valor da indutância é 

conseguido através de um aumento da área da bobina. Tendo um conta todos estes factores, 

uma bobina de aproximadamente 30nH. 

se por definir a frequência da solução no simulador 

bobinas foram simuladas, começando 

), seguidamente foi feito um estudo para 

se mais simulações para escolher a largura das 

mais o factor de qualidade, foram simuladas 
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6.2.2. Diâmetro interior (Din) 

 

Para começar o desenho desta bobina, optou-se por utilizar uma largura da pista 

W=14µm e um espaçamento entre pistas S=3µm. A escolha destes valores sucede do facto de se 

necessitar de um elevado factor de qualidade, por isso um W=14µm e S=3µm, permite começar 

as simulações para a escolha do diâmetro interior (Din), sem ter-mos de nos preocupar no final 

com as possíveis interferências que possam ocorrer na variação de outros parâmetros, pois estes 

parâmetros iniciais, não devem estar muito afastados dos parâmetros óptimos. Os únicos 

parâmetros que variam são o diâmetro interior e o número de voltas, com o intuito de manter 

aproximadamente constante o valor da indutância de todas as bobinas simuladas. 

As características das 6 bobinas simuladas encontram-se na tabela seguinte. 

 

Din (µm) 110 154 204 272 360 488 

Dout (µm) 444 454 470 504 558 652 

Voltas 10 9 8 7 6 5 

Largura (µm) 14 14 14 14 14 14 

Espaçamento (µm) 3 3 3 3 3 3 

Modified Wheeler (nH) 30.64 30.72 30.41 30.68 30.50 30.02 

Current Sheet (nH) 30.71 30.54 30.09 30.35 30.41 30.64 

Monomial Fit (nH) 29.20 29.45 29.33 29.80 29.97 30.18 

Tabela 2.4: Características das bobinas simuladas para escolher Din (900 MHz) 
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Os resultados obtidos para o valor da indutância e factor de qualidade apresentam-se de seguida. 

 

Figura 6.11: Indutância das 6 bobinas simuladas – variação de Din 

 

Figura 6.12: Factor de qualidade das 6 bobinas simuladas – variação de Din 
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Como seria de esperar, a 900MHz as bobinas apresentam valores de indutância 

semelhantes, excepção feita para a bobina cujo Din=488µm que apresenta um valor ligeiramente 

superior. Os valores máximos do factor de qualidade encontram-se numa gama de frequências 

estreita o que significa que apresentam aproximadamente o mesmo número de perdas no 

substrato, pois as bobinas foram desenhadas de forma a terem uma área aproximadamente 

constante. 

A 900MHz, a bobina cujo Din=154µm, apresenta o melhor factor de qualidade, logo um 

menor número de perdas, sendo este a diâmetro interior escolhido para proceder às simulações 

nos passos seguintes. 

 

6.2.3. Espaçamento entre espiras (S) 

 

Para se verificar qual o melhor espaçamento entre espiras para esta frequência e 

diâmetro interior, 4 bobinas foram simuladas, variando unicamente o espaçamento entre as 

espiras. 

As características dessas bobinas encontram-se na tabela seguinte. 

 

Din (µm) 154 154 154 154 

Dout (µm) 438 454 470 488 

Voltas 9 9 9 9 

Largura (µm) 14 14 14 14 

Espaçamento (µm) 2 3 4 5 

Modified Wheeler (nH) 30.40 30.72 31.06 31.41 

Current Sheet (nH) 30.20 30.54 30.90 31.28 

Monomial Fit (nH) 29.21 29.45 29.80 30.21 

Tabela 2.5: Características das bobinas simuladas para escolher S (900 MHz) 
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Os resultados obtidos para o valor da indutância e factor de qualidade, foram os seguintes. 

 

Figura 6.13: Indutância das 4 bobinas simuladas – variação de S 

 

Figura 6.14: Factor de qualidade das 4 bobinas simuladas – variação de S 
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Com o aumento do espaçamento, verifica-se uma melhoria pouco significativa do factor 

de qualidade. O caso mais grava verificava-se quando S=2µm, pois quer o efeito de proximidade 

quer a capacidade entre as pistas adjacentes, acabam por exercer um efeito negativo quer na 

resistência do metal quer na frequência de trabalho, respectivamente. 

A partir de S=2, o aumento do espaçamento acaba por não influenciar muito o factor de 

qualidade, levando a um aumento da área consumida. Pelo facto de estar relativamente alinhado 

com a frequência da simulação, escolheu-se a bobina com o espaçamento S=3µm. 

 

6.2.4. Largura da pista (W) 

 

Fixando o diâmetro interior, espaçamento entre pistas e o número de voltas, simularam-

se 6 bobinas para escolher qual a largura da pista que apresentava melhor desempenho. 

 

As características dessas 6 bobinas estão descritas na tabela seguinte. 

 

Din (µm) 154 154 154 154 154 154 

Dout (µm) 382 454 490 526 562 598 

Voltas 9 9 9 9 9 9 

Largura (µm) 10 14 16 18 20 22 

Espaçamento (µm) 3 3 3 3 3 3 

Modified Wheeler (nH) 29.42 30.72 31.50 32.34 33.22 34.13 

Current Sheet (nH) 29.14 30.54 31.37 32.26 33.20 34.17 

Monomial Fit (nH) 28.18 29.45 30.23 31.07 31.96 32.89 

Tabela 2.6: Características das bobinas simuladas para escolher W (900 MHz) 
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Os resultados obtidos nas simulações encontram-se a seguir. 

 

Figura 6.15: Indutância das 6 bobinas simuladas – variação de W 

 

Figura 6.16: Factor de qualidade das 6 bobinas simuladas – variação de W 
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Os resultados apresentam uma variação quer do valor máximo do factor de qualidade, 

quer da posição desse máximo. Este resultado já era esperado tendo em conta os resultados 

obtido nas secções anteriores. 

A 900MHz, o factor de qualidade é máximo para a bobina com a largura da pista 

W=18µm, revelando ser a bobina com menores perdas a esta frequência. 

O deslocamento para uma frequência inferior, verificado com o aumento da largura da 

pista, prende-se com o facto de haver um aumento da capacidade para o substrato devido a um 

aumento significativo da área, que ocorre quando se aumenta a largura da pista, mantendo fixos 

os restantes parâmetros. 

 

6.2.5. Bobina multi-camada 

 

Tal como no ponto 6.1.5, neste ponto procedeu-se à simulação da bobina optimizada 

anteriormente, mas desta vez, usando 2 camadas adjacentes de metal com o objectivo de 

diminuir a resistência do condutor. Para interligar as duas camadas de metal, um número elevado 

de vias foi utilizado, de forma a diminuir a influência que a relativa alta resistividade das vias 

possa induzir no desempenho da bobina. 

A bobina simulada tem as características que foram escolhidas nos passos anteriores 

(W=18µm, Din=154µm), com a excepção do espaçamento que se aumentou 0.5µm passando a ser 

de S=3.5µm. Esta alteração foi efectuada de forma a compensar um aumento na capacidade para 

o substrato devido ao facto de a bobina se encontrar mais próximo do mesmo, o que levaria a um 

deslocamento para uma frequência mais baixa do valor máximo do factor de qualidade.  

 

 

 

 

 

 

 

 

 

 

 



 

Os resultados obtidos foram os seguintes:

Figura 6.17

 

Figura 6.18: Factor de qualidade para 

 

Nélson Miguel da Silva Ricardo
Indutores Integrados para Sistemas de Recolha de Energia sem 

ados obtidos foram os seguintes: 

17: Indutância para a bobina com 2 camadas de metal (900MHz)

Factor de qualidade para a bobina com 2 camadas de metal (900
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MHz) 

 

2 camadas de metal (900MHz) 



 

Os resultados obtidos 

bobina com a utilização de 2 camadas adjacentes de metal. Esta melhoria é justificada com uma 

redução da resistência do condutor, o que diminui consideravelmente as perdas.

Quanto ao valor da indutância,

sendo que a sua frequência de ressonância ainda se encontra bastant

esta bobina pode operar nesta gama de frequências sem qualquer tipo de problemas.

Tal como se tinha previst

mais baixa do valor máximo do factor de qualidade. Este deslocamento foi atenuado com o

aumento do espaçamento para S=3.5µm.

Procedeu-se ainda à simulação da mesma

adjacentes de metal para a bobina

ligação desde a volta interior até ao exterior. Verifica

do factor de qualidade para uma fre

substrato. Felizmente, as perdas resistivas são atenuadas. A utilização das 3 camadas de metal 

interligadas por vias, resulta numa r

máximo do factor de qualidade. Os resultados obtidos podem ser co

seguintes (ver figura 6.19 e 6.20)

à bobina original (com apenas uma camada de metal).

Figura 6.19
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Os resultados obtidos mostram uma melhoria considerável do factor de qualidade da

com a utilização de 2 camadas adjacentes de metal. Esta melhoria é justificada com uma 

redução da resistência do condutor, o que diminui consideravelmente as perdas.

Quanto ao valor da indutância, a 900MHz apresenta um valor de aproximadamente 35nH, 

sendo que a sua frequência de ressonância ainda se encontra bastante afastada dos 900MHz, logo 

pode operar nesta gama de frequências sem qualquer tipo de problemas.

Tal como se tinha previsto anteriormente, ocorreu um deslocamento para uma frequência 

mais baixa do valor máximo do factor de qualidade. Este deslocamento foi atenuado com o

aumento do espaçamento para S=3.5µm. 

se ainda à simulação da mesma bobina, mas agora utilizando 3 camadas 

bobina e a camada mais próxima do substrato para providenciar a 

ligação desde a volta interior até ao exterior. Verifica-se novamente a uma deslocação do máximo 

do factor de qualidade para uma frequência mais baixa, devido ao aumento da capacidade para o 

. Felizmente, as perdas resistivas são atenuadas. A utilização das 3 camadas de metal 

interligadas por vias, resulta numa redução da resistividade da bobina, aumentando o valor 

actor de qualidade. Os resultados obtidos podem ser consultados nas figuras 

(ver figura 6.19 e 6.20) onde se observa que o Q (a 900MHz) melhorou 

original (com apenas uma camada de metal). 

19: Indutância para a bobina com 3 camadas de metal (900MHz)
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erável do factor de qualidade da 

com a utilização de 2 camadas adjacentes de metal. Esta melhoria é justificada com uma 

redução da resistência do condutor, o que diminui consideravelmente as perdas. 

a 900MHz apresenta um valor de aproximadamente 35nH, 

e afastada dos 900MHz, logo 

pode operar nesta gama de frequências sem qualquer tipo de problemas. 

o anteriormente, ocorreu um deslocamento para uma frequência 

mais baixa do valor máximo do factor de qualidade. Este deslocamento foi atenuado com o 

, mas agora utilizando 3 camadas 

e a camada mais próxima do substrato para providenciar a 

se novamente a uma deslocação do máximo 

quência mais baixa, devido ao aumento da capacidade para o 

. Felizmente, as perdas resistivas são atenuadas. A utilização das 3 camadas de metal 

, aumentando o valor 

nsultados nas figuras 

melhorou 68% em relação 

 

camadas de metal (900MHz) 



 

 

Figura 6.20: Factor de qualidade para a
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: Factor de qualidade para a bobina com 3 camadas de metal (900MHz)
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camadas de metal (900MHz) 



 

6.3. Desenhos finais da

 

6.3.1. Bobina optimizad

 

A bobina optimizada para 433MHz tem as seguintes características:

• Diâmetro interior D

• Diâmetro exterior Dout=769µm

• Largura da pista W=30µm

• Espaçamento entre espiras S=2µm

• Número de voltas N=6
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Desenhos finais das bobinas optimizados para 433MHz e 900MHz

optimizada para 433MHz 

para 433MHz tem as seguintes características: 

Diâmetro interior Din=389µm 

Diâmetro exterior Dout=769µm 

Largura da pista W=30µm 

Espaçamento entre espiras S=2µm 

Número de voltas N=6 

Figura 6.21: Bobina optimizada para 433MHz 
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optimizados para 433MHz e 900MHz 

 



 

6.3.2. Bobina optimizada

 

A bobina optimizada para 900MHz tem as seguintes características:

• Diâmetro interior D

• Diâmetro exterior D

• Largura da pista W=18µm

• Espaçamento entre espiras S=3.5µm

• Número de voltas N=9
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Bobina optimizada para 900MHz 

para 900MHz tem as seguintes características: 

Diâmetro interior Din=154µm 

Diâmetro exterior Dout=534µm 

Largura da pista W=18µm 

Espaçamento entre espiras S=3.5µm 

Número de voltas N=9 

Figura 6.22: Bobina optimizada para 900MHz 
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7. Bobinas com Patterned Ground Shields

 

7.1. Metodologia 

 

No capítulo 2 já foram discutidos quais os objectivos que se pretendem alc

introdução de Patterned Ground Shield

utilização consiste na tentativa de terminar o c

substrato, antes de este penetrar no mesmo

no substrato devido ao campo eléctrico

Diversos escudos foram desenhados e sim

electromagnético. Contudo, devido à complexa estrutura desenhada, os requisitos 

computacionais são elevados, o que

efectuar um estudo muito aprofundado destas estrutura

Tendo em conta a capacidade computacional disponível, 

tem um número de voltas inferior 

exteriores (Dout) semelhantes.
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Patterned Ground Shields 

No capítulo 2 já foram discutidos quais os objectivos que se pretendem alc

Patterned Ground Shields em bobinas integradas. O principal propósito da sua 

consiste na tentativa de terminar o campo eléctrico existente entre a

substrato, antes de este penetrar no mesmo, evitando assim, o surgimento de correntes induzidas 

devido ao campo eléctrico. 

Diversos escudos foram desenhados e simulados no simulador de campo 

electromagnético. Contudo, devido à complexa estrutura desenhada, os requisitos 

putacionais são elevados, o que devido à capacidade computacional disponível, não permitiu 

efectuar um estudo muito aprofundado destas estruturas. 

Tendo em conta a capacidade computacional disponível, a bobina utilizada

inferior em relação à bobina optimizada para 900MHz, mas dimensões 

) semelhantes. 

Figura 7.1: Estrutura de simulação com PGS 
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No capítulo 2 já foram discutidos quais os objectivos que se pretendem alcançar com a 

s. O principal propósito da sua 

ampo eléctrico existente entre a bobina e o 

, evitando assim, o surgimento de correntes induzidas 

ulados no simulador de campo 

electromagnético. Contudo, devido à complexa estrutura desenhada, os requisitos 

devido à capacidade computacional disponível, não permitiu 

bobina utilizada nestas simulações 

para 900MHz, mas dimensões 

 



 

Todos os escudos desenhados apresentam uma 

pela conexão entre as diversas 

conectada ao ponto de referência a partir do centro e pode

 

 

Esta conexão cruzada

impossibilita a formação de um circuito fechado quer entre as 

Nesta análise, começou

compõe o escudo, na performa

para perceber a sua influência no comportamento da

ranhuras foi mantido constante e igual a 2µm

deste parâmetro, pois não havia capacidade computacional 

que deve ser mantido no mínimo valor possível, para evitar a p

substrato. 
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Todos os escudos desenhados apresentam uma ligação cruzada em alumínio responsável 

diversas ranhuras de polisilício que compõem o PGS. Essa

ao ponto de referência a partir do centro e pode-se verificar na imagem seguinte:

Figura 7.2: PGS com conexão em Alumínio 

cruzada, permite que a ligação do escudo seja feita num ponto simétrico e 

impossibilita a formação de um circuito fechado quer entre as ranhuras quer no metal.

começou-se por verificar a influência da condutividade do material que 

na performance da bobina. Posteriormente, a largura das ranhuras foi alterada 

a influência no comportamento da bobina. O espaçamento entre as diversa

ranhuras foi mantido constante e igual a 2µm. Não foi possível verificar a influência da diminuição 

deste parâmetro, pois não havia capacidade computacional suficiente, contudo é um parâmetro 

que deve ser mantido no mínimo valor possível, para evitar a passagem do campo eléctrico para o 
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em alumínio responsável 

Essa ligação cruzada é 

icar na imagem seguinte: 

 

que a ligação do escudo seja feita num ponto simétrico e 

quer no metal. 

se por verificar a influência da condutividade do material que 

a largura das ranhuras foi alterada 

. O espaçamento entre as diversas 

. Não foi possível verificar a influência da diminuição 

, contudo é um parâmetro 

assagem do campo eléctrico para o 
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7.2. Variação da condutividade do PGS 

 

Foram simulados 5 escudos cuja largura das ranhuras foi mantida constante e igual a 

18µm. Como já foi referido anteriormente, o espaçamento entre as ranhuras foi de 2µm. Os 

materiais utilizados para a construção do escudo foram polisilício, cobre, condutor perfeito (PEC). 

Como termo de comparação, foi simulado uma bobina sem escudo. 

Os Resultados obtidos podem ser consultados nas figuras 7.3 e 7.4. 

 

 

Figura 7.3: Indutância das 5 bobinas simuladas (variação da condutividade do PGS) 
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Figura 7.4: Factor de qualidade das 5 bobinas simuladas (variação da condutividade do PGS) 

 

Variando a condutividade do material que compõe o escudo ranhurado, verifica-se uma 

diminuição do valor da indutância com o aumento da condutividade e um aumento do factor de 

qualidade com o aumento da condutividade. No entanto, o factor de qualidade obtido fica aquém 

do esperado, sendo em todos os casos simulados inferior ao da bobina sem escudo, devido 

possivelmente a algum erro na estrutura ou no perfil de simulação, ou devido simplesmente à 

elevada largura das ranhuras e elevado espaçamento entre ranhuras. Mas como já foi referido 

anteriormente, não foi possível aprofundar o estudo deste tipo de estruturas devido ao esforço 

computacional necessário. 

O aumento verificado no factor de qualidade com o aumento da condutividade justifica-se 

com o facto de o principal objectivo do escudo ser o de terminar o campo eléctrico antes de este 

penetrar no substrato providenciando uma ligação à massa. Quanto menor a resistividade desta 

conexão, menor serão as perdas e melhor o factor de qualidade. Contudo, o máximo do factor de 

qualidade desloca-se para uma frequência mais baixa devido ao aumento da capacidade, pois o 

escudo encontra-se mais próximo da bobina, comparativamente ao substrato. 
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7.3.  Variação da largura das ranhuras do PGS 

 
Foram simuladas 3 bobinas cuja largura das ranhuras foi variada. Os escudos simulados 

tinham largura da ranhura de 3µm, 8µm, 18µm e foram todos construídos com polisilício. Como já 

foi referido anteriormente, o espaçamento entre as ranhuras foi mantido constante e igual a 

2µm. Como termo de comparação, foi simulada uma bobina sem escudo. 

Os resultados obtidos para a indutância e factor de qualidade encontram-se nas figuras 

7.5 e 7.6. 

 

Figura 7.5: Indutância das 3 bobinas simuladas (variação da largura das ranhuras) 
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Figura 7.5: Factor de qualidade das 3 bobinas simuladas (variação da largura das ranhuras) 

 

Verifica-se um aumento do factor de qualidade com a diminuição da largura das ranhuras 

e não se verifica uma variação significativa do valor da indutância comparativamente às outras 

bobinas simuladas com escudo de polisilicio. Tal como no ponto anterior, verifica-se uma 

diminuição do factor de qualidade comparativamente à bobina sem escudo. 

A partir dos resultados obtidos anteriormente, conclui-se que a diminuição da largura das 

ranhuras afecta positivamente a performance da bobina. Infelizmente, devido às elevadas 

dimensões da bobina para esta gama de frequências, não foi possível efectuar um estudo 

aprofundado sobre patterned ground shields. Contudo, para a sua utilização, deve ser feito 

previamente um estudo que pode ser realizado utilizando um simulador de campo 

electromagnético e uma máquina com grande capacidade computacional. Em [29] apresenta-se 

mais um método que não aumenta o custo de fabrico da bobina e que pode melhorar 

substancialmente o desempenho da mesma. Neste método, constrói-se um novo escudo, 

recorrendo à camada n+. Na superfície do bloco de silício são então aplicados dois escudos de 

forma a melhorar o factor de qualidade da bobina. 
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8. Simulação da Transmissão de Energia a 433MHz e 

900MHz 

 

8.1. Objectivos 

 

Nesta fase final do trabalho, procedeu-se à simulação da transmissão de energia 

utilizando como receptoras as bobinas optimizadas para 433MHz e 900MHz (com 2 camadas de 

metal e sem patterned ground shield), para assim comprovar que é possível transferir energia 

suficiente para alimentar um circuito implantado, recorrendo ao acoplamento indutivo entre duas 

bobinas. 

O procedimento utilizado foi semelhante ao descrito no capítulo 4, onde se utilizou o 

Ansoft HFSS para simular a transmissão de energia e posteriormente exportar a matriz dos 

parâmetros S obtida para o Ansoft Designer, para assim ser possível realizar simulações no 

domínio do tempo.  

Infelizmente o tempo e recursos computacionais disponíveis, não permitiram aprofundar 

este tópico devido ao facto de também ser necessário desenhar, simular e optimizar a bobina 

emissora, já que a bobina emissora utilizada no capítulo 4, não é usável nesta gama de 

frequências. 

 

8.2. Simulação da Transmissão de Energia a 433MHz 

 

8.2.1. Bobina Emissora 

 

A bobina emissora é quadrada com um número de voltas N=6, o seu diâmetro exterior é 

de DOUT= 1044µm, a largura da pista é de W=34µm, o espaçamento entre pistas é de S=3µm e a 

espessura do metal é de 10µm. A condutividade do metal que compõe a bobina emissora é de 

900000000S/m, sendo portanto um valor propositadamente e irrealisticamente elevado. Este 

expediente foi utilizado para obtermos uma bobina emissora com Q elevado (aproximadamente 

100) sem grande esforço, pois o trabalho desta tese focou a bobina integrada. Recorrendo às 

expressões aproximadas para o cálculo do valor da indutância apresentadas no capítulo 2, a 

indutância desta bobina é de 48nH. 

 



 

O seu desenho no simulador de campo electromagnético

 

 

Procedendo à simulação com o objectivo de calcular o valor da indutância e factor de 

qualidade da bobina emissora, definindo previamente a frequência da solução para 433MHz 

(frequência a que é optimizada a malha de elementos), os resultados obtidos para o valor da 

indutância e factor de qualidade apresentam

Figura 8.2: Gráfico da
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O seu desenho no simulador de campo electromagnético encontra-se na imagem seguinte.

Figura 8.1: Bobina Emissora (48nH) 

simulação com o objectivo de calcular o valor da indutância e factor de 

qualidade da bobina emissora, definindo previamente a frequência da solução para 433MHz 

(frequência a que é optimizada a malha de elementos), os resultados obtidos para o valor da 

tância e factor de qualidade apresentam-se seguidamente (ver figuras 8.2 e 8.3).

Figura 8.2: Gráfico da Indutância vs Frequência para a bobina emissora

lson Miguel da Silva Ricardo 
s para Sistemas de Recolha de Energia sem Fios 

94 

se na imagem seguinte. 

 

simulação com o objectivo de calcular o valor da indutância e factor de 

qualidade da bobina emissora, definindo previamente a frequência da solução para 433MHz 

(frequência a que é optimizada a malha de elementos), os resultados obtidos para o valor da 

se seguidamente (ver figuras 8.2 e 8.3). 

 

Indutância vs Frequência para a bobina emissora 



 

Figura 8.3: Gráfico do factor de qualidade vs Frequência para a bobina emissora

 

Os valores obtidos 

próximos do valor teórico. A 433MHz

aproximadamente 90. 

 

8.2.2. Bobina Receptora

 

Como já foi anteriormente referido, a bobina receptora utilizada nestas simu

bobina com 2 camadas de metal optimizada para os 433MHz, apresentada no capítulo 6. Devido 

ao esforço computacional necessário e ao tempo limitado, não foi possível realizar estas 

simulações utilizando a mesma bobina receptora mas composta por

metal para a construção da mesma (bobina com melhor factor de qualidade).

Recordando as características desta bobina, ela é composta por N=6 voltas em alumínio, o 

diâmetro exterior é de DOUT=769µm, a largura da pista é de W=30µm e 

espiras é de S=2µm. Como já foi referido, esta bobina recorre a duas camadas adjacentes de 

metal (Metal 4 e Metal 3) interligadas por um elevado número de vias para realizar a bobina.
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Gráfico do factor de qualidade vs Frequência para a bobina emissora

 para a indutância através da simulação encontram

próximos do valor teórico. A 433MHz o factor de qualidade da bobina

Bobina Receptora 

Como já foi anteriormente referido, a bobina receptora utilizada nestas simu

bobina com 2 camadas de metal optimizada para os 433MHz, apresentada no capítulo 6. Devido 

ao esforço computacional necessário e ao tempo limitado, não foi possível realizar estas 

simulações utilizando a mesma bobina receptora mas composta por 3 camadas adjacentes de 

metal para a construção da mesma (bobina com melhor factor de qualidade). 

Recordando as características desta bobina, ela é composta por N=6 voltas em alumínio, o 

=769µm, a largura da pista é de W=30µm e o espaçamento entre 

espiras é de S=2µm. Como já foi referido, esta bobina recorre a duas camadas adjacentes de 

metal (Metal 4 e Metal 3) interligadas por um elevado número de vias para realizar a bobina.
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Gráfico do factor de qualidade vs Frequência para a bobina emissora 

para a indutância através da simulação encontram-se bastante 

o factor de qualidade da bobina emissora é 

Como já foi anteriormente referido, a bobina receptora utilizada nestas simulações foi a 

bobina com 2 camadas de metal optimizada para os 433MHz, apresentada no capítulo 6. Devido 

ao esforço computacional necessário e ao tempo limitado, não foi possível realizar estas 

3 camadas adjacentes de 

 

Recordando as características desta bobina, ela é composta por N=6 voltas em alumínio, o 

o espaçamento entre 

espiras é de S=2µm. Como já foi referido, esta bobina recorre a duas camadas adjacentes de 

metal (Metal 4 e Metal 3) interligadas por um elevado número de vias para realizar a bobina. 



 

O seu desenho no simulador de campo 

 

Figura 8.4: Bobina Receptora

 

Os resultados para a indutância e factor de qualidade já foram obtidos por simulação no 

capítulo 6, no entanto são novamente aqui apresentados 

 

Figura 8.5: Indutância da bo
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O seu desenho no simulador de campo electromagnético encontra-se na figura seguinte.

Figura 8.4: Bobina Receptora (30nH – 2 camadas de metal) 

Os resultados para a indutância e factor de qualidade já foram obtidos por simulação no 

capítulo 6, no entanto são novamente aqui apresentados (ver figuras 8.5 e 8.6).

Figura 8.5: Indutância da bobina com 2 camadas de metal (433MHz)
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se na figura seguinte. 

 

Os resultados para a indutância e factor de qualidade já foram obtidos por simulação no 

(ver figuras 8.5 e 8.6). 

 

MHz) 



 

Figura 8.6: Factor de qualidade

 

 

8.2.3. Resultados da Simulação a 433MHz

 

Para realizar a simulação da transferência de 

com suas partes superiores viradas uma para a outra e com os seus centros perfeitamente 

alinhados. A distância que separa as duas bobinas foi variada de forma a verificar a dependência 

da tensão induzida com a distância entre as bobinas. Tal como no capítulo 4, foram utilizadas 4 

portas de excitação (lumped ports

Após a realização das simulações, as matrizes dos parâmetros S obtidas, foram exportadas 

de forma a poderem ser utilizadas no software Ansost Designer, para proceder à realização de 

simulações no domínio do tempo, como explicado no capítulo 4.

O circuito utilizado (ver figura 8.7) é constituído por 2 circuitos LC, por uma fonte de 

corrente (200mA), uma carga de 10KΩ e

modelo eléctrico do nosso sistema sobre teste. Neste bloco, os terminais 1 e 2 dizem respeito à 

bobina emissora, enquanto os terminais 3 e 4 dizem respeito à bobina receptora.
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Factor de qualidade da bobina com 2 camadas de metal (433

Resultados da Simulação a 433MHz 

Para realizar a simulação da transferência de energia sem fios, as bobinas foram colocadas 

com suas partes superiores viradas uma para a outra e com os seus centros perfeitamente 

alinhados. A distância que separa as duas bobinas foi variada de forma a verificar a dependência 

istância entre as bobinas. Tal como no capítulo 4, foram utilizadas 4 

lumped ports), sendo aplicadas duas a cada bobina. 

Após a realização das simulações, as matrizes dos parâmetros S obtidas, foram exportadas 

ilizadas no software Ansost Designer, para proceder à realização de 

simulações no domínio do tempo, como explicado no capítulo 4. 

O circuito utilizado (ver figura 8.7) é constituído por 2 circuitos LC, por uma fonte de 

corrente (200mA), uma carga de 10KΩ e por num bloco “DUT” com os pinos 1,2,3 e 4 que é o 

modelo eléctrico do nosso sistema sobre teste. Neste bloco, os terminais 1 e 2 dizem respeito à 

bobina emissora, enquanto os terminais 3 e 4 dizem respeito à bobina receptora.
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bina com 2 camadas de metal (433MHz) 

energia sem fios, as bobinas foram colocadas 

com suas partes superiores viradas uma para a outra e com os seus centros perfeitamente 

alinhados. A distância que separa as duas bobinas foi variada de forma a verificar a dependência 

istância entre as bobinas. Tal como no capítulo 4, foram utilizadas 4 

Após a realização das simulações, as matrizes dos parâmetros S obtidas, foram exportadas 

ilizadas no software Ansost Designer, para proceder à realização de 

O circuito utilizado (ver figura 8.7) é constituído por 2 circuitos LC, por uma fonte de 

por num bloco “DUT” com os pinos 1,2,3 e 4 que é o 

modelo eléctrico do nosso sistema sobre teste. Neste bloco, os terminais 1 e 2 dizem respeito à 

bobina emissora, enquanto os terminais 3 e 4 dizem respeito à bobina receptora. 



 

Figura 8.7: Circuito 

 

 

Para uma distância entre as duas bobinas de 5mm, obteve

 

Figura 8.
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: Circuito utilizado para proceder à análise no domínio do tempo

Para uma distância entre as duas bobinas de 5mm, obteve-se a seguinte tensão induzida:

Figura 8.8: Tensão induzida a uma distância de 5mm 
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utilizado para proceder à análise no domínio do tempo (433MHz) 

se a seguinte tensão induzida: 

 



 

Para uma distância entre as duas bobinas de

 

Figura 8.

 

 

Os resultados obtidos permitem verificar a dependência existente entre a tensão induzida 

e a distância entre as duas bobinas. A uma distância de 2mm, a tensão induzida é de 

(264µW). O valor obtido é bastante aceitável, 

o facto de esta mesma bobina não ter sido grandemente optimizada e o facto de a bobina 

receptora não ser a bobina que recorre a 3 camadas adjacentes de metal (bobina com melhor 

factor de qualidade). Na realidade, a bobina emissora não sof

a bobina receptora. Por esta raz

melhor factor de qualidade, é possível melhorar ainda mais a transmissão de energia.

 

8.3. Simulação da Transmiss

 

8.3.1. Bobina Emissora

 

A bobina emissora é quadrada com um 

exterior DOUT= 712µm, a largura da pista 
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Para uma distância entre as duas bobinas de 2mm, obteve-se a seguinte tensão induzida:

Figura 8.9: Tensão induzida a uma distância de 2mm 

Os resultados obtidos permitem verificar a dependência existente entre a tensão induzida 

e a distância entre as duas bobinas. A uma distância de 2mm, a tensão induzida é de 

O valor obtido é bastante aceitável, tendo em conta as dimensões da

o facto de esta mesma bobina não ter sido grandemente optimizada e o facto de a bobina 

receptora não ser a bobina que recorre a 3 camadas adjacentes de metal (bobina com melhor 

factor de qualidade). Na realidade, a bobina emissora não sofre as restrições de espaço que sofre 

a bobina receptora. Por esta razão, realizando uma bobina emissora de maiores dimensões e 

melhor factor de qualidade, é possível melhorar ainda mais a transmissão de energia.

Simulação da Transmissão de Energia a 900MHz 

Bobina Emissora 

é quadrada com um número de voltas N=6, sendo o seu diâmetro 

= 712µm, a largura da pista é de W=26µm, o espaçamento entre pistas
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se a seguinte tensão induzida: 

 

Os resultados obtidos permitem verificar a dependência existente entre a tensão induzida 

e a distância entre as duas bobinas. A uma distância de 2mm, a tensão induzida é de 1.15VP 

tendo em conta as dimensões da bobina emissora, 

o facto de esta mesma bobina não ter sido grandemente optimizada e o facto de a bobina 

receptora não ser a bobina que recorre a 3 camadas adjacentes de metal (bobina com melhor 

re as restrições de espaço que sofre 

ão, realizando uma bobina emissora de maiores dimensões e 

melhor factor de qualidade, é possível melhorar ainda mais a transmissão de energia. 

de voltas N=6, sendo o seu diâmetro 

, o espaçamento entre pistas é de S=8µm e 



 

espessura do metal é de 10µm. A condutividade do metal que

900000000S/m. Recorrendo às expressões aproximadas para o cálculo do valor da indutância 

apresentadas no capítulo 2, a indutância desta bobina é de 26nH

campo electromagnético encontra

 

 

Definindo previamente a frequência da solução para 900MHz, procedeu

com o objectivo de calcular o valor da indutância e factor d

resultados obtidos para o valor da indutância e factor de qualidade apresentam

(ver figuras 8.11 e 8.12). 

Figura 8.11
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10µm. A condutividade do metal que compõe a bobina emissora é de 

900000000S/m. Recorrendo às expressões aproximadas para o cálculo do valor da indutância 

apresentadas no capítulo 2, a indutância desta bobina é de 26nH. O seu desenho no simulador de 

campo electromagnético encontra-se na imagem seguinte. 

Figura 8.10: Bobina Emissora (26nH) 

Definindo previamente a frequência da solução para 900MHz, procedeu

com o objectivo de calcular o valor da indutância e factor de qualidade da bobina emissora. O

o valor da indutância e factor de qualidade apresentam

1: Gráfico da Indutância vs Frequência para a bobina emissora
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compõe a bobina emissora é de 

900000000S/m. Recorrendo às expressões aproximadas para o cálculo do valor da indutância 

O seu desenho no simulador de 

 

Definindo previamente a frequência da solução para 900MHz, procedeu-se à simulação 

e qualidade da bobina emissora. Os 

o valor da indutância e factor de qualidade apresentam-se seguidamente 

 

: Gráfico da Indutância vs Frequência para a bobina emissora 



 

Figura 8.12: Gráfico do factor de qualidade vs Frequência para a bobina emissora

 

Os valores obtidos para a indutância através da simulação encontram

próximos do valor teórico. O factor de qualidade da bobina

muito próximo dos 900MHz. 

 

8.3.2. Bobina Receptora

 

A bobina receptora utilizada nestas simulações foi a bobina

optimizada para os 900MHz

referido. Não foi possível realizar estas simulações utilizando a mesma bobina receptor

composta por 3 camadas adjacentes de metal (bobina 

ao esforço computacional necessário. 

por N=9 voltas em alumínio, o diâmetro exterior é de D

W=18µm e o espaçamento entre espiras é de S=3.5µm. Como já foi

a duas camadas adjacentes de metal (

vias para realizar a bobina. 
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: Gráfico do factor de qualidade vs Frequência para a bobina emissora

Os valores obtidos para a indutância através da simulação encontram

O factor de qualidade da bobina emissora tem o seu valor máximo 

 

Bobina Receptora 

bobina receptora utilizada nestas simulações foi a bobina com 2 camadas de metal

optimizada para os 900MHz que foi apresentada no capítulo 6, como já foi anteriormente 

foi possível realizar estas simulações utilizando a mesma bobina receptor

composta por 3 camadas adjacentes de metal (bobina com melhor factor de qualidade), devido 

ao esforço computacional necessário. Recordando as características desta bobina, ela é composta 

por N=9 voltas em alumínio, o diâmetro exterior é de DOUT=534µm, a largura da pista é de 

W=18µm e o espaçamento entre espiras é de S=3.5µm. Como já foi referido, esta bobina recorre 

duas camadas adjacentes de metal (Metal 4 e Metal 3) interligadas por um 
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: Gráfico do factor de qualidade vs Frequência para a bobina emissora 

Os valores obtidos para a indutância através da simulação encontram-se bastante 

emissora tem o seu valor máximo 

com 2 camadas de metal 

, como já foi anteriormente 

foi possível realizar estas simulações utilizando a mesma bobina receptora mas 

com melhor factor de qualidade), devido 

Recordando as características desta bobina, ela é composta 

, a largura da pista é de 

referido, esta bobina recorre 

) interligadas por um elevado número de 



 

O seu desenho no simulador de campo electromag

 

Figura 8.

 

Os resultados para a indutância e factor de qualidade já foram obtidos por simulação no 

capítulo 6, no entanto são novamente aqui apresentados (ver figuras 8.

Figura 8.1
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nho no simulador de campo electromagnético encontra-se na figura 8.13

Figura 8.13: Bobina Receptora (30nH – 2 camadas de metal) 

Os resultados para a indutância e factor de qualidade já foram obtidos por simulação no 

novamente aqui apresentados (ver figuras 8.14 e 8.15

14: Indutância da bobina com 2 camadas de metal (900MHz)
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se na figura 8.13. 

 

Os resultados para a indutância e factor de qualidade já foram obtidos por simulação no 

14 e 8.15). 

 

: Indutância da bobina com 2 camadas de metal (900MHz) 



 

Figura 8.15: Factor de qualidade da bobina com 2 camadas de metal (900MHz)

 

 

8.3.3. Resultados da Simulação

 

Para realizar a simulação da transferência de energia sem fios, as bobinas foram colocadas 

com suas partes superiores viradas uma para a outra e com os seus centros perfeitamente 

alinhados, semelhante ao realizado no ponto 8.2.3

bobinas de forma a verificar a dependência da tensão induzida com a distância entre 

como no capítulo 4, foram utilizadas 4 portas de excitação (

cada bobina. 

Após a realização das simulações, as matrizes dos p

de forma a poderem ser utilizadas no software Ansos

simulações no domínio do tempo, como explicado no capítulo 4.

O circuito utilizado (ver figura 8.

carga de 10KΩ e num bloco “DUT” com os pinos 1,2,3 e 4 que 

sistema sobre teste. Neste bloco, os terminais 1 e 2 dizem respeito à bobina emissora, enquanto 

os terminais 3 e 4 dizem respeito à bobina recept
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: Factor de qualidade da bobina com 2 camadas de metal (900MHz)

Resultados da Simulação a 900MHz 

simulação da transferência de energia sem fios, as bobinas foram colocadas 

com suas partes superiores viradas uma para a outra e com os seus centros perfeitamente 

, semelhante ao realizado no ponto 8.2.3. Variou-se a distância que separa 

de forma a verificar a dependência da tensão induzida com a distância entre 

como no capítulo 4, foram utilizadas 4 portas de excitação (lumped ports), sendo aplicadas duas a 

Após a realização das simulações, as matrizes dos parâmetros S obtidas, foram exportadas 

ser utilizadas no software Ansost Designer, para proceder à realização de 

simulações no domínio do tempo, como explicado no capítulo 4. 

rcuito utilizado (ver figura 8.16) consiste numa fonte de corrente (200mA), numa 

carga de 10KΩ e num bloco “DUT” com os pinos 1,2,3 e 4 que é o modelo eléctrico do nosso 

sistema sobre teste. Neste bloco, os terminais 1 e 2 dizem respeito à bobina emissora, enquanto 

dizem respeito à bobina receptora. 
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: Factor de qualidade da bobina com 2 camadas de metal (900MHz) 

simulação da transferência de energia sem fios, as bobinas foram colocadas 

com suas partes superiores viradas uma para a outra e com os seus centros perfeitamente 

distância que separa as duas 

de forma a verificar a dependência da tensão induzida com a distância entre ambas. Tal 

), sendo aplicadas duas a 

arâmetros S obtidas, foram exportadas 

t Designer, para proceder à realização de 

orrente (200mA), numa 

é o modelo eléctrico do nosso 

sistema sobre teste. Neste bloco, os terminais 1 e 2 dizem respeito à bobina emissora, enquanto 



 

Figura 8.16: Circuito utilizado para proceder à análise no domínio do tempo

 

 

Para uma distância entre as duas bobinas de 5mm, obteve

 

Figura 8.1
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: Circuito utilizado para proceder à análise no domínio do tempo

Para uma distância entre as duas bobinas de 5mm, obteve-se a seguinte tensão induzida:

Figura 8.17: Tensão induzida a uma distância de 5mm 
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: Circuito utilizado para proceder à análise no domínio do tempo 

se a seguinte tensão induzida: 

 



 

Para uma distância entre as duas bobinas de 2mm, obteve

Figura 8.18

 

Os resultados obtidos permitem verificar a dependência existente entre a tensão induzida

e a distância entre as duas bobinas. A uma d

(88µW). Tendo novamente em conta as dimensões

pode-se concluir que os resultados obtidos são muito aceitáveis, para além 

não ser a bobina que recorre a 3 camadas adjacentes de metal (bobina com melhor factor de 

qualidade). Mais uma vez, a bobina emissora não sofre as restrições de espaço que sofre a bobina 

receptora, logo realizando uma bobina emissora 

qualidade será possível transmitir mais energi
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entre as duas bobinas de 2mm, obteve-se a seguinte tensão induzida:

Figura 8.18: Tensão induzida a uma distância de 2mm 

Os resultados obtidos permitem verificar a dependência existente entre a tensão induzida

e a distância entre as duas bobinas. A uma distância de 2mm, a tensão induzida é de 665mV

em conta as dimensões e o nível de optimização 

se concluir que os resultados obtidos são muito aceitáveis, para além de a bobina receptora 

não ser a bobina que recorre a 3 camadas adjacentes de metal (bobina com melhor factor de 

a bobina emissora não sofre as restrições de espaço que sofre a bobina 

realizando uma bobina emissora de maiores dimensões e melhor factor de 

será possível transmitir mais energia. 
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se a seguinte tensão induzida: 

 

Os resultados obtidos permitem verificar a dependência existente entre a tensão induzida 

istância de 2mm, a tensão induzida é de 665mVP 

 da bobina emissora, 

de a bobina receptora 

não ser a bobina que recorre a 3 camadas adjacentes de metal (bobina com melhor factor de 

a bobina emissora não sofre as restrições de espaço que sofre a bobina 

de maiores dimensões e melhor factor de 
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9. Conclusões 

 

Esta tese focou-se no estudo, desenho e posterior simulação de bobinas planares 

integradas, usando um simulador de campo electromagnético. 

As bobinas desempenham um papel fundamental num elevado número de circuitos de 

RF, sendo o componente crítico em muitos desses circuitos, pois é componente passivo que mais 

se desvia do modelo ideal. No caso das bobinas planares integradas, a proximidade entre a bobina 

e o substrato condutivo é um dos problemas que mais afecta a performance da bobina, 

juntamente com todos os fenómenos de alta frequência que podem ocorrer e aumentar a 

resistividade do metal que compõe a bobina. 

Usando o simulador de campo electromagnético, comprovaram-se os resultados obtidos 

num projecto anterior, onde se procedeu à transmissão de energia sem fios. Esta fase do projecto 

foi bastante importante pois, para além de permitir um conhecimento mais profundo do 

problema, foi um meio de conhecer todas as potencialidades do simulador e tomar conhecimento 

das ferramentas necessárias para a realização das simulações, assim como verificar a precisão 

deste. 

Depois de adquirido todo o conhecimento necessário para proceder às simulações e 

terem sido definidos todos os parâmetros da tecnologia no simulador, procedeu-se a um estudo 

sistemático de bobinas planares integradas através de simulação. No simulador, foram 

desenhadas bobinas com valores semelhantes de indutância, para investigar a influência do 

diâmetro interior, espaçamento e largura das pistas na performance da bobina integrada. Os 

resultados obtidos, indicam que as bobinas necessitam de um diâmetro interior considerável para 

impedir que sejam induzidas correntes parasitas nas espiras interiores, o que levaria a um 

aumento da resistência. Quanto ao espaçamento, deve-se prestar especial atenção ao efeito de 

proximidade e à capacidade entre as pistas adjacentes. A largura das pistas é um parâmetro muito 

importante pois influencia o valor da indutância por unidade de comprimento, a resistência do 

condutor e é um parâmetro que permite afinar, dentro de certos limites, o valor máximo do 

factor de qualidade para a frequência de trabalho. Estes resultados estão em linha com o que é 

apresentado na literatura. 

Tendo em conta as conclusões obtidas no Capítulo 5, duas novas bobinas foram 

desenhados usando a mesma metodologia. Essas bobinas foram optimizadas para frequências de 

433MHz e 900MHz. Utilizando duas camadas adjacentes de metal, simularam-se as duas bobinas 

previamente optimizadas e verificaram-se melhorias do factor de qualidade, devido 
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essencialmente à diminuição da resistividade do metal. Os factores de qualidade obtidos foram 

de 6.3 e 7.3 para as bobinas de 433MHz e 900MHz respectivamente. Procedeu-se ainda à 

simulação destas duas bobinas utilizando 3 camadas adjacentes de metal para construir a bobina. 

Em ambos os casos verificou-se um aumento do factor de qualidade das bobinas apesar de um 

aumento da capacidade entre a bobina e o substrato. 

A metodologia utilizada anteriormente, tem a vantagem de poder ser utilizada para 

optimizar bobinas integradas planares em qualquer tipo de tecnologia CMOS. 

A introdução de patterned ground shields não obteve os resultados que se esperariam, 

como por exemplo a melhoria do factor de qualidade. Infelizmente, como o tempo e os recursos 

computacionais não foram os suficientes, não foi possível fazer um estudo mais aprofundado 

acerca deste tema. No entanto, conclui-se que a diminuição da largura das ranhuras que formam 

o escudo, contribui positivamente para o factor de qualidade da bobina. 

No capítulo 8, procedeu-se à simulação da transmissão de energia, mas utilizando como 

bobinas receptoras as bobina optimizadas para 433MHz e 900MHz que utilizam duas camadas 

adjacentes de metal. Os resultados obtidos foram muito encorajadores, conseguindo-se obter no 

receptor 665mVP (88µW) e 1.15VP (264µW) a 900MHz e 433MHz respectivamente. Na construção 

do sistema final, deverá ser dada mais atenção ao projecto da bobina emissora que deverá ter 

maiores dimensões para dessa maneira, termos bons resultados a distâncias superiores às aqui 

apresentadas. 

Os resultados obtidos são bastante encorajadores, sugerindo que é possível integrar a 

bobina num circuito integrado em tecnologia CMOS convencional. 

Para trabalho futuro, fica a produção do layout das bobinas no software de desenho de 

circuitos integrados Cadence [33], e a sua integração com os outros blocos já projectados em [3] e 

[35] de um circuito integrado. 
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Anexo - Tutorial HFSS: 

 

 O tutorial que se segue, tem como objectivo mostrar como se desenha e simula 

integradas, usando o ambiente e as capacidades providenciadas pelo Ansoft HFSS.

explica como se inserem gráficos para visualizar os resultados obtidos directamente no simulador.

 Antes de começar com o tutorial propriamente dito, são apresentadas as principais 

secções que compõem o ambiente de trabalho do simulador. Essas s

indicadas na figura 9.1 e são as seguintes:

• Janela do 3D Modeler

utilizados para a construção dessa estrutura organizados numa hierarquia.

• Janela Project Manager,

proceder à simulação da estrutura. Grande parte das definições, pode ser aplicada através 

desta janela, sem recorrer à barra de menus.

• Placar de mensagens, 

proceder à simulação.

• Janela de progresso, 

 

Figura 

Placar de 
mensagens 

Janela 
Project 
Manager 

Tutorial HFSS: Bobina Integrada 

O tutorial que se segue, tem como objectivo mostrar como se desenha e simula 

, usando o ambiente e as capacidades providenciadas pelo Ansoft HFSS.

explica como se inserem gráficos para visualizar os resultados obtidos directamente no simulador.

Antes de começar com o tutorial propriamente dito, são apresentadas as principais 

secções que compõem o ambiente de trabalho do simulador. Essas secções encontram

indicadas na figura 9.1 e são as seguintes: 

Janela do 3D Modeler, que contém a estrutura a ser analisada e todos os objectos 

utilizados para a construção dessa estrutura organizados numa hierarquia.

Janela Project Manager, onde se encontram quase todas as definições adoptadas para 

proceder à simulação da estrutura. Grande parte das definições, pode ser aplicada através 

desta janela, sem recorrer à barra de menus. 

Placar de mensagens, onde são listados os erros e os warnings que ocorram a

proceder à simulação. 

 que exibe o desenvolvimento da simulação. 

Figura 10.1: Secções do ambiente de trabalho do simulador 

O tutorial que se segue, tem como objectivo mostrar como se desenha e simula bobinas 

, usando o ambiente e as capacidades providenciadas pelo Ansoft HFSS. Também se 

explica como se inserem gráficos para visualizar os resultados obtidos directamente no simulador. 

Antes de começar com o tutorial propriamente dito, são apresentadas as principais 

ecções encontram-se 

, que contém a estrutura a ser analisada e todos os objectos 

utilizados para a construção dessa estrutura organizados numa hierarquia. 

tram quase todas as definições adoptadas para 

proceder à simulação da estrutura. Grande parte das definições, pode ser aplicada através 

onde são listados os erros e os warnings que ocorram antes de se 

 

Janela de 
Progresso 

Janela do 
3D Modeler 



Já com o conhecimento básico das principais secções que compõem o ambiente de 

trabalho do simulador, é apresentada na figura 9.2, as principais características da tecnologia 

utilizada. Os valores utilizados para os parâmetros tecnológicos, não dizem respeito a nenhuma 

tecnologia em particular. São valores definidos apenas para utilização neste tutorial, mas 

encontram-se dentro da gama de valores encontrados em grande parte das tecnologias actuais. 

 

 

Figura 10.2: Secção transversal da tecnologia criada 

 

A bobina que vai ser simulada neste tutorial, vai ser desenhada na 4ª camada cujo metal é 

cobre. O underpass e as vias são de alumínio. Como a resistividade das vias é relativamente 

elevada face aos restantes metais utilizados, utiliza-se um elevado número de vias para 

providenciar a ligação entre a bobina e o underpass. Este elevado número de vias tem como 

objectivo reduzir a resistividade das conexões. Neste tutorial, são utilizados dois blocos de 

alumínio cujas dimensões são muito superiores às das vias, para realizar essas duas conexões. 

Estes dois blocos, simulam esse elevado número de vias, reduzindo a complexidade do desenho. 

Quanto à bobina em particular, esta terá as principais características: 

• Número de voltas N=3.5 

• Espaçamento S=2.0µm 

• Largura da pista W=14µm 

• Diâmetro interior Din=100µm 

  



Início do Tutorial 

Execução do Programa 

 Por defeito, o programa é instalado em Programas > Ansoft > HFSS 10. Clicando em HFSS, 

o programa passa a ser executado, aparecendo o ambiente de trabalho já descrito anteriormente. 

Por defeito, o simulador ao ser iniciado, arranca com um projecto em branco com o nome 

Projec1. Acedendo à janela Project Manager, podemos alterar o nome do projecto, bem como 

adicionar mais do que um desenho (estrutura) a esse mesmo projecto. É importante referir que 

caso seja necessário alterar o nome do projecto, isso deve ser feito no simulador e não utilizando 

o explorador do Windows, pois o simulador necessita de alterar o nome do projecto na pasta 

onde são armazenados os valores obtidos nas simulações. 

 Acedendo à janela Project Manager, alterou-se o nome do projecto de Project1 para 

Indutor. 

 

Dicas para qualquer tipo de projecto 

• Definir previamente as unidades do modelo que vai ser desenhado; 

• Caso seja necessário desenhar num mesmo modelo estruturas iguais mas em diferentes 

posições, a ferramenta Mirror Duplicate ou a criação de sistemas de coordenadas 

relativas, facilita o desenho do modelo. 

• É ainda possível importar modelos provenientes de outro tipo de software, o que pode 

facilitar o desenho de estruturas complexas. 

 

 

 

 

 

 

 

 



Definir o tipo de solução

Para definir o tipo de solução

1. Na barra de menus seleccione 

2. Aparece a janela:

3. Escolha Driven Terminal

 

Para perceber qual o tipo de solução que deve ser escolhido, deve ser consultado o 

manual, onde se encontra uma explicação detalhada deste aspecto e de muitos

bastante informativo e completo.

 

Definição das unidades da estrutura

 Para definir as unidades da estrutura:

1. Na barra de menus seleccione 

2. Aparece a janela:

 

3. Escolha µm e pressione 

Definir o tipo de solução 

Para definir o tipo de solução gerada: 

Na barra de menus seleccione HFSS > Solution Type… 

Aparece a janela: 

Figura 10.3: Janela Solution Type 

Driven Terminal e pressione OK. 

Para perceber qual o tipo de solução que deve ser escolhido, deve ser consultado o 

manual, onde se encontra uma explicação detalhada deste aspecto e de muitos

bastante informativo e completo. 

Definição das unidades da estrutura 

Para definir as unidades da estrutura: 

Na barra de menus seleccione 3D Modeler > Units… 

Aparece a janela: 

 

Figura 10.4: Janela Set Model Units 

e pressione OK. 

 

Para perceber qual o tipo de solução que deve ser escolhido, deve ser consultado o 

manual, onde se encontra uma explicação detalhada deste aspecto e de muitos outros, sendo 



Definição dos materiais

 Para adicionar um tipo de material à lista de materiais do HFSS:

1. Na barra de ferramentas seleccione 

Figura 

2. Aparece uma janela com uma lista de materiais e respectivas carac

Clique em Add Material

3. No campo Value

campo Material Name

4. Clique em Validate Material

material passará a estar disponível na lista de materiais.

 

Neste tutorial, proceda como explicado anteriormente para introduzir os 3 materiais 

necessários, cujas característi

 

Material Name 

Bulk Conductivity (S/m) 

Relative Permittivity 

Definição dos materiais 

Para adicionar um tipo de material à lista de materiais do HFSS:

Na barra de ferramentas seleccione Select em: 

 

Figura 10.5: Barra de ferramentas Select Materials 

Aparece uma janela com uma lista de materiais e respectivas carac

Add Material e aparecerá a seguinte janela: 

 

Figura 10.6: Janela View/Edit Material 

Value, insira o devido valor na característica correspondente e no 

Material Name, insira o nome que pretende para o material.

Validate Material para validar o material. Em seguida pressione 

material passará a estar disponível na lista de materiais. 

Neste tutorial, proceda como explicado anteriormente para introduzir os 3 materiais 

necessários, cujas características encontram-se especificadas na tabela seguinte.

My_Oxide My_Subs 

 0 0.0006 

4.1 11.8 

Tabela 1: Características dos materiais a definir 

Para adicionar um tipo de material à lista de materiais do HFSS: 

Aparece uma janela com uma lista de materiais e respectivas características. 

, insira o devido valor na característica correspondente e no 

, insira o nome que pretende para o material. 

para validar o material. Em seguida pressione OK e o 

Neste tutorial, proceda como explicado anteriormente para introduzir os 3 materiais 

se especificadas na tabela seguinte. 

My_Pass 

0 

7.9 



 O cobre e o alumínio utilizados da construção da

encontram na lista que vem por defeito com o simulador.

 

Criação da Estrutura

Criação do Substrato 

Para criar o substrato

1. Na barra de ferramentas 

2. Na barra de menus seleccione 

3. Aparecem então uns campos onde se podem inserir coordenadas.

coordenada de um ponto extremo da caixa que será o substrato. Insira X=

Y=-300, Z=0 e pressione 

usar a tecla Tab

4. Insira agora o comprimento das 3 dimensões da caixa que será o substrato. Insira 

dX=600, dY=600, dZ=300 e pressione 

5. Aparece então a janela das propriedades, onde podemos alterar as coordenadas, 

dimensões, tipo de ma

Altere também a cor e transparência a seu gosto

 

6. Para visualizar o substrato pressione 

ínio utilizados da construção da bobina, não foram definidos pois já se 

encontram na lista que vem por defeito com o simulador. 

Criação da Estrutura 

Para criar o substrato: 

Na barra de ferramentas Select Material, escolha My_Subs 

Na barra de menus seleccione Draw > Box 

Aparecem então uns campos onde se podem inserir coordenadas.

coordenada de um ponto extremo da caixa que será o substrato. Insira X=

300, Z=0 e pressione Enter. Para passar de uma coordenada pa

Tab. 

Insira agora o comprimento das 3 dimensões da caixa que será o substrato. Insira 

00, dY=600, dZ=300 e pressione Enter. 

então a janela das propriedades, onde podemos alterar as coordenadas, 

dimensões, tipo de material, nome, etc. Altere o nome de Box1

Altere também a cor e transparência a seu gosto. 

Figura 10.7: Janela das Propriedades 

Para visualizar o substrato pressione Ctrl+D. 

, não foram definidos pois já se 

Aparecem então uns campos onde se podem inserir coordenadas. Insira então a 

coordenada de um ponto extremo da caixa que será o substrato. Insira X=-300, 

. Para passar de uma coordenada para a outra pode 

Insira agora o comprimento das 3 dimensões da caixa que será o substrato. Insira 

então a janela das propriedades, onde podemos alterar as coordenadas, 

Box1 para Substrato. 

 



Criação do Óxido 

 Para criar o oxido: 

1. Na barra de ferramentas Select Material, escolha My_Oxide 

2. Na barra de menus seleccione Draw > Box 

3. No campo das coordenadas insira X=-300, Y=-300, Z=300 e pressione Enter. 

4. Insira agora o comprimento das 3 dimensões da caixa que será o óxido. Insira 

dX=600, dY=600, dZ=7.5 e pressione Enter. 

5. Altere o nome de Box1 para Óxido. Altere também a cor e transparência a seu 

gosto. 

6. Pressione Ctrl+D para visualizar toda a estrutura. 

Criação da Protecção 

 Para criar a protecção: 

1. Na barra de ferramentas Select Material, escolha My_Pass 

2. Na barra de menus seleccione Draw > Box 

3. No campo das coordenadas insira X=-300, Y=-300, Z=307.5 e pressione Enter. 

4. Insira agora o comprimento das 3 dimensões da caixa que será a protecção. Insira 

dX=600, dY=600, dZ=1 e pressione Enter. 

5. Altere o nome de Box1 para Prot. Altere também a cor e transparência a seu 

gosto. 

6. Pressione Ctrl+D para visualizar toda a estrutura. 

Criação da “Caixa de Ar” 

 Para criar o oxido: 

1. Na barra de ferramentas Select Material, escolha vacuum 

2. Na barra de menus seleccione Draw > Box 

3. No campo das coordenadas insira X=-300, Y=-300, Z=0 e pressione Enter. 

4. Insira agora o comprimento das 3 dimensões da caixa que será a “caixa de ar”. 

Insira dX=600, dY=600, dZ=800 e pressione Enter. 

5. Altere o nome de Box1 para Ar. Altere a cor a seu gosto e especifique a 

transparência para 0.9 ou terá dificuldade em visualizar toda a estrutura. 

6. Pressione Ctrl+D para visualizar toda a estrutura. 



Definir a “caixa de ar” como superfície de radiação:

1. Seleccione a “caixa de ar” clicando sobre ela ou na barra de 

Select > By Name…

2. Depois de ter seleccionado a “caixa de ar”, n

Boundaries > Assign > Radiation…

3. Na janela que surge, pressione simplesmente 

 

Neste momento deve ter uma estrutura deste género:

 

 

Definir a “caixa de ar” como superfície de radiação: 

Seleccione a “caixa de ar” clicando sobre ela ou na barra de 

Select > By Name… 

Depois de ter seleccionado a “caixa de ar”, na barra de menus seleccione 

Boundaries > Assign > Radiation… 

Na janela que surge, pressione simplesmente OK. 

Neste momento deve ter uma estrutura deste género: 

Figura 10.8: Estrutura base da simulação 

 

Seleccione a “caixa de ar” clicando sobre ela ou na barra de menus em Edit > 

a barra de menus seleccione HFSS > 

 



Criação da Bobina 

Criação de um novo sistema de coordenadas. 

 Para criar um novo sistema de coordenadas 

1. Na barra de menus clique em 3D Modeler > Coordinate System > Create > 

Relative CS > Offset. 

2. No campo das coordenadas insira X=0, Y=0, Z=305 e pressione Enter 

Criação da bobina em espiral 

 Para criar uma linha: 

1. Na barra de menus seleccione Draw > Line 

2. Usando os campos das coordenadas, insira linha a linha no campo respectivo, os 

valores presentes na tabela seguinte, pressione Enter. Enquanto inserir os valores 

nos respectivos campos não utilize o rato. Quando inserir todas as linhas, clique 

no lado direito do rato e seleccione Done.  

 

X (μm) Y (μm) Z (μm) 

-108 0 0 

-108 108 0 

108 108 0 

108 -100 0 

-92 -100 0 

-92 92 0 

92 92 0 

92 -84 0 

-76 -84 0 

-76 76 0 

76 76 0 

76 -68 0 

-60 -68 0 

-60 60 0 

60 60 0 

60 0 0 

Tabela 2: Coordenadas para desenhar a bobina 

3. Aparece então a janela das propriedades. Clique OK. 



Alteração do plano da grelha 

1. Na barra de menus seleccione 3D Modeler > Grid Plane > XZ 

Criação do condutor 

1. Na barra de ferramentas Select Material, escolha Copper 

2. Na barra de menus seleccione Draw > Rectangle 

3. No campo das coordenadas insira X=-108, Y=0, Z=0 e pressione Enter 

4. No campo das coordenadas insira dX=14, dY=0, dZ=2 e pressione Enter 

5. Aparece a janela das propriedades. Defina o nome como espiral 

6. Seleccione os objectos Polynide1 e espiral em Edit > Select > By Name… 

7. Na barra de menus seleccione Draw > Sweep > Along Path 

8. Clique em OK 

9. Na janela de propriedades que aparece seleccione a opção Solve Inside 

Alteração do plano da grelha 

1. Na barra de menus seleccione 3D Modeler > Grid Plane > XY 

Criação das extensões da bobina 

1. Na barra de menus seleccione Draw > Box 

2. No campo das coordenadas insira X=110, Y=0, Z=0 e pressione Enter 

3. No campo das coordenadas insira dX=30, dY=14, dZ=2 e pressione Enter 

4. Na janela de propriedades que aparece, edite o nome para ext1, seleccione a 

opção Solve Inside e clique em OK 

5. Na barra de menus seleccione Draw > Box 

6. No campo das coordenadas insira X=-108, Y=0, Z=0 e pressione Enter 

7. No campo das coordenadas insira dX=-32, dY=14, dZ=2 e pressione Enter 

8. Na janela de propriedades que aparece, edite o nome para ext2, seleccione a 

opção Solve Inside e clique em OK 

9. Seleccione os objectos ext1, ext2 e espiral em Edit > Select > By Name… 

10. Na barra de menus seleccione 3D Modeler > Boolean > Unite 

11. Altere o nome da bobina de ext1 para espiral 



 

Limitar o número de tetraedros na bobina a 50000 

1. Seleccione o objecto espiral em Edit > Select > By Name… 

2. Na barra de menus clique em HFSS > Mesh Operations > Assign > Inside Selection 

> Length Based… 

3. Aparece a janela Element Length Based Refinement. Defina: 

a. Restrict Length of Elements: Off 

b. Restrict Number of Elements: On 

c. Maximum Number of Elements: 50000 

Criação da via 1 

1. Na barra de ferramentas Select Material, escolha aluminum 

2. Na barra de menus seleccione Draw > Box 

3. No campo das coordenadas insira X=49, Y=3, Z=0 e pressione Enter 

4. No campo das coordenadas insira dX=8, dY=8, dZ=-1 e pressione Enter 

5. Na janela de propriedades que aparece, defina o nome como via1 e seleccione a 

opção Solve Inside 

Criação da via 2 

1. Na barra de menus seleccione Draw > Box 

2. No campo das coordenadas insira X=113, Y=3, Z=0 e pressione Enter 

3. No campo das coordenadas insira dX=8, dY=8, dZ=-1 e pressione Enter 

4. Na janela de propriedades que aparece, defina o nome como via2 e seleccione a 

opção Solve Inside 

Criação do underpass 

1. Na barra de menus seleccione Draw > Box 

2. No campo das coordenadas insira X=49, Y=3, Z=-1 e pressione Enter 

3. No campo das coordenadas insira dX=72, dY=8, dZ=-0.5 e pressione Enter 

4. Na janela de propriedades que aparece, defina o nome como underpass e 

seleccione a opção Solve Inside 

 

 

 



A bobina deve apresentar esta configuração:

 

 

 

 

Criação do Guard Ring

 Criação do anel exterior

1. Na barra de ferramentas 

2. Na barra de menus seleccione 

3. No campo das coordenadas insira X=

4. No campo das coordenadas insira dX=500, dY=500, dZ=2 e pressione 

5. Aparece a janela das propriedades. Defina o nome como 

deve apresentar esta configuração: 

Figura 10.9: Estrutura base já com a bobina 

Criação do Guard Ring 

Criação do anel exterior 

Na barra de ferramentas Select Material, escolha Pec 

Na barra de menus seleccione Draw > Box 

No campo das coordenadas insira X=-250, Y=-250, Z=0 e pressione 

No campo das coordenadas insira dX=500, dY=500, dZ=2 e pressione 

Aparece a janela das propriedades. Defina o nome como ring 

 

250, Z=0 e pressione Enter 

No campo das coordenadas insira dX=500, dY=500, dZ=2 e pressione Enter 

 



Criação do anel interior 

1. Na barra de menus seleccione Draw > Box 

2. No campo das coordenadas insira X=-236, Y=-236, Z=0 e pressione Enter 

3. No campo das coordenadas insira dX=472, dY=472, dZ=2 e pressione Enter 

4. Aparece a janela das propriedades. Defina o nome como interior 

5. Seleccione os objectos ring e interior em Edit > Select > By Name… 

6. Na barra de menus clique em 3D Modeler > Boolean > Subtract 

7. Aparece a janela na qual define: 

a. Blank Parts: ring 

b. Tool Parts: interior 

c. Clique OK 

Criação de extensões para o guard ring 

1. Na barra de menus seleccione Draw > Box 

2. No campo das coordenadas insira X=-250, Y=0, Z=0 e pressione Enter 

3. No campo das coordenadas insira dX=96, dY=14, dZ=2 e pressione Enter 

4. Aparece a janela das propriedades. Defina o nome como ext1 

5. Seleccione o objecto ext1 em Edit > Select > By Name… 

6. Na barra de menus seleccione Edit > Duplicate > Mirror 

7. No campo das coordenadas insira X=0, Y=0, Z=0 e pressione Enter 

8. No campo das coordenadas insira dX=1, dY=0, dZ=0 e pressione Enter 

9. Seleccione os objectos ext1, ext1_1 e ring em Edit > Select > By Name… 

10. Na barra de menus clique em 3D Modeler > Boolean > Unite 

11. Altere o nome do guard ring de ext1_1 para guard_ring 

 

 

 

 

 

 

 

 

 

 



A estrutura deve apresentar uma configuração semelhante a:

 

Figura 10

 

A estrutura deve apresentar uma configuração semelhante a: 

Figura 10.10: Estrutura base com bobina e guard ring. 

 

 



Aplicar as Fontes de Excitação 

Criação da 1ª fonte de excitação 

 Para criar a fonte de excitação: 

1. Na barra de menus seleccione Draw > Rectangle 

2. No campo das coordenadas insira X=-140, Y=0, Z=1 e pressione Enter 

3. No campo das coordenadas insira dX=-14, dY=14, dZ=2 e pressione Enter 

4. Aparece a janela das propriedades. Defina o nome como port1 

Para definir a fonte de excitação: 

1. Em Edit > Select > By Name…, seleccione o objecto port1 

2. Na barra de menus clique em HFSS > Excitations > Assign > Lumped Port 

3. Aparece a janela Lumped Port: General. Defina: 

a. Name: p1 

b. Resistance: 50Ohm 

c. Reactance: 0Ohm 

4. Clique em seguinte 

5. Aparece a janela Lumped Port: Modes. Defina: 

a. Number of Modes: 1 

b. Integration Line: New Line 

c. No campo das coordenadas insira X=-154, Y=7, Z=1 e pressione Enter 

d. No campo das coordenadas insira dX=14, dY=0, dZ=0 e pressione Enter 

6. Aparece a janela Lumped Port: Post Processing. Seleccione: 

a. Renormalize All Modes 

i. Full Port Impedance: 50Ohm 

7. Clique em Finalizar 

Criação da 2ª fonte de excitação 

 Para criar a fonte de excitação: 

1. Na barra de menus seleccione Draw > Rectangle 

2. No campo das coordenadas insira X=1540, Y=0, Z=1 e pressione Enter 

3. No campo das coordenadas insira dX=-14, dY=14, dZ=2 e pressione Enter 

4. Aparece a janela das propriedades. Defina o nome como port2 



Para definir a fonte de excitação: 

1. Em Edit > Select > By Name…, seleccione o objecto port2 

2. Na barra de menus clique em HFSS > Excitations > Assign > Lumped Port 

3. Aparece a janela Lumped Port: General. Defina: 

a. Name: p2 

b. Resistance: 50Ohm 

c. Reactance: 0Ohm 

4. Clique em seguinte 

5. Aparece a janela Lumped Port: Modes. Defina: 

a. Number of Modes: 1 

b. Integration Line: New Line 

c. No campo das coordenadas insira X=154, Y=7, Z=1 e pressione Enter 

d. No campo das coordenadas insira dX=-14, dY=0, dZ=0 e pressione Enter 

6. Aparece a janela Lumped Port: Post Processing. Seleccione: 

a. Renormalize All Modes 

i. Full Port Impedance: 50Ohm 

7. Clique em Finalizar 

  



Definições da Análise 

Definir o perfil de análise 

 Para definir o perfil de análise: 

1. Na barra de menus clique em HFSS > Analysis Setup > Add Solution Setup 

2. Aparece a janela Solution Setup. 

a. Em General defina: 

i. Solution Frequency: 4.5GHz 

ii. Maximum Number of Passes: 20 

iii. Maximum Delta S: 0.02 

b. Em Options defina: 

i. Do Lambda Refinement: ON 

ii. Target: 0.05 

iii. Maximum Refinement Per Pass: 20% 

iv. Minium Number of Passes: 1 

v. Maximum Converged Passes: 1 

vi. Use Low-Order Solution Basis: ON 

c. Clique em OK 

Definir um varrimento na frequência 

 Para definir um varrimento na frequência: 

1. Na barra de menus clique em HFSS > Analysis Setup > Add Sweep 

2. Seleccione o Setup 1 

3. Aparece a janela Edit Sweep 

a. Em Sweep Type defina: 

i. Interpolating 

ii. Max Solutions: 20 

iii. Error Tolerance: 0.5% 

b. Em Frequency Setup defina: 

i. Type: Linear Step 

ii. Start: 0.1GHz 

iii. Stop: 16GHz 



iv. Step SIze: 0.1GHz 

c. Clique em OK 

Validação do Modelo 

 Para validar o modelo: 

1. Na barra de menus clique em HFSS > Validation Check 

 

Se tudo estiver bem, só surgirão warnings. Caso exista algum erro, no painel de 

mensagens será indicado qual o tipo de erro. 

Simulação 

 Para proceder à simulação: 

1. Na barra de menus clique em HFSS > Analyze All 

  



Visualização dos resultados 

Definir expressões 

 Vamos adicionar duas expressões que serão utilizadas nos gráficos seguintes. 

 

� = ��(���)
	
(���)

 

 

� =
�� � 1����

2 ∗ �� ∗ �	
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 Para definir expressões: 

1. Na barra de menus clique em HFSS > Results > Output Variables… 

2. Aparece a janela Output Variables. Defina L como: 

a. Name: L 

b. Expression: 

i. Insira: im(1/ 

ii. Category: Y Parameter – duplo clique em Y(p1,p1). Feche os 

parênteses 

iii. Insira: /(2*pi*freq) 

iv. Clique em Add 

3. Continuando na janela Output Variables, defina Q como: 

a. Name: Q 

b. Expression: 

i. Category: Y Parameter 

ii. Quantity: Y(p1,p1) 

iii. Function: im 

iv. Clique em Insert Quantity Into Expression 

v. Insira: / 

vi. Category: Y Parameter 

vii. Quantity: Y(p1,p1) 

viii. Function: re 

ix. Clique em Insert Quantity Into Expression 

x. Clique em Add 



4. Clique em Done 

Adicionar gráficos 

 Para adicionar o gráfico de L com os resultados obtidos: 

1. Na barra de menus clique em HFSS > Results > Create Report… 

2. Aparece a janela Create Report. Defina: 

a. Report Type: Modal Solution Data 

b. Display Type: Rectangular Plot 

3. Aparece a janela Traces. Seleccione: 

a. Solution: Setup1 : Sweep1 

b. Domain: Sweep 

c. Category: Output variables 

d. Quantity: L 

e. Function: <none> 

4. Clique em Add Trace 

5. Clique em Done 

Para adicionar o gráfico de Q com os resultados obtidos: 

1. Na barra de menus clique em HFSS > Results > Create Report… 

2. Aparece a janela Create Report. Defina: 

a. Report Type: Modal Solution Data 

b. Display Type: Rectangular Plot 

3. Aparece a janela Traces. Seleccione: 

a. Solution: Setup1 : Sweep1 

b. Domain: Sweep 

c. Category: Output variables 

d. Quantity: Q 

e. Function: abs 

4. Clique em Add Trace 

5. Clique em Done 

 

 

 



Os gráficos dos resultados obtidos para L e Q são os seguintes:Os gráficos dos resultados obtidos para L e Q são os seguintes:

Figura 10.11: Indutância vs Frequência 

Figura 10.12: Factor de Qualidade da bobina 

Os gráficos dos resultados obtidos para L e Q são os seguintes: 

 

 


